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Safety Guidelines

This manual contains notices which you should observe to ensure your own personal safety, as
well as to protect the product and connected equipment. These notices are highlighted in the
manual by a warning triangle and are marked as follows according to the level of danger:

Danger

' Danger indicates an imminently hazardous situation which, if not avoided, will result in death or

serious injury.

Warning

' Warning indicates a potentially hazardous situation which, if not avoided, could result in death or

serious injury.

Caution

' Caution used with the safety alert symbol indicates a potentially hazardous situation which, if not

Caution

avoided, may result in minor or moderate injury.

Caution used without the safety alert symbol indicates a potentially hazardous situation which, if

not avoided, may result in property damage.

Notice

Notice indicates a potential situation which, if not avoided, may result in an undesirable result or

State.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified
persons are defined as persons who are authorized to commission, to ground, and to tag circuits,
equipment, and systems in accordance with established safety practices and standards.

Correct Usage
Note the following:
Warning

This device and its components may only be used for the applications described in the catalog
or the technical descriptions, and only in connection with devices or components from other

manufacturers which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and
installed correctly, and operated and maintained as recommended.

Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of SIEMENS AG.

Some of other designations used in these documents are also registered trademarks; the owner’s rights may be
violated if they are used by third parties for their own purposes.

Copyright Siemens AG 2008 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for damages.
All rights, including rights created by patent grant or registration of autility model
or design, are reserved.

Siemens AG

Bereich Automation and Drives
Geschaeftsgebiet Industrial Automation Systems
Postfach 4848, D- 90327 Nuernberg

Disclaimer of Liability

We have checked the contents of thismanual for agreement with the hardware and
software described. Since deviations cannot be precluded entirely, we cannot
guarantee full agreement. However, the datain this manual are reviewed regularly
and any necessary corrections included in subsequent editions. Suggestions for
improvement are welcomed.

© Siemens AG 2008
Technical data subject to change.

Siemens Aktiengesellschaft

6ES7298-8FA24-8BHO



Preface

Purpose of the manual

The S7-200 series is a line of micro-programmable logic controllers (Micro PLCs) that can control
a variety of automation applications. Compact design, low cost, and a powerful instruction set
make the S7-200 a perfect solution for controlling small applications. The wide variety of S7-200
models and the Windows-based programming tool give you the flexibility you need to solve your
automation problems.

This manual provides information about installing and programming the S7-200 Micro PLCs and
is designed for engineers, programmers, installers, and electricians who have a general
knowledge of programmable logic controllers.

Required Basic Knowledge

To understand this manual, it is necessary to have a general knowledge of automation and
programmable logic controllers.

Scope of the Manual

This manual is valid for STEP 7-Micro/WIN, version 4.0 and the S7-200 CPU product family. For
a complete list of the S7-200 products and order numbers described in this manual, see
Appendix A.

Changes compared to the previous version

This manual has been revised to include two new analog expansion modules and one additional
appendix.

1 EM 231 Analog Input RTD, 4 Inputs
1 EM 231 Analog Input Thermocouple 8 Inputs
1 Appendix H, S7-200CN Products

Certification
The SIMATIC S7-200 products have the following certification:

1 Underwriters Laboratories, Inc. UL 508 Listed (Industrial Control Equipment),
Registration number E75310

1 Canadian Standards Association: CSA C22.2 Number 142 (Process Control Equipment)

1 Factory Mutual Research: Class Number 3600, Class Number 3611, FM Class I, Division 2,
Groups A, B, C, & D Hazardous Locations, T4A and Class |, Zone 2, IIC, T4

Tip
@ The SIMATIC S7-200 series meets the CSA standard.

The cULus logo indicates that the S7-200 has been examined and certified by Underwriters
Laboratories (UL) to standards UL 508 and CSA 22.2 No. 142.
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CE Labeling

Refer to the General Technical Specifications in Appendix A for more information.

C-Tick

The SIMATIC S7-200 products are compliant with requirements of the AS/NZS 2064 (Australian)
standard.

Standards:

The SIMATIC S7-200 products fulfill the requirement and criteria of IEC 61131-2, Programmable
controllers - Equipment requirements.

Refer to Appendix A for additional compliance information.

Place of this Documentation in the Information Environment

Product

Family Documentation Order Number

S7-200 | S7-200 Point-to-Point Interface Communication Manual (English/German) | 6ES7 298-8GA00-8XH0

SIMATIC Text Display User Manual (included on the STEP 7-Micro/WIN none
documentation CD)

HMI device OP 73micro, TP 177micro (WinCC Flexible) Operating 6AV6 691-1DF01-0ABO
Instructions (English)

SIMATIC HMI WinCC flexible 2005 Micro User’s Manual (English) 6AV6 691-1AA01-0ABO
SIMATIC NET CP 243-2 AS-Interface Master Manual (English) 6GK7 243-2AX00-8BA0

SIMATIC NET CP 243-1 Communications processor of Industrial Ethernet = J31069-D0428-U001-A2-7618
Technical Manual (English)

SIMATIC NET CP 243-1 IT Communications Processor of Industrial J31069-D0429-U001-A2-7618
Ethernet and Information Technology Technical Manual (English)

SIMATIC NET S7Beans / Applets for IT-CPs Programming Tips (English) | C79000-G8976-C180-02
SIMATIC NET GPRS/GSM-Modem SINAUT MD720-3 System manual C79000-G8976-C211

(English)

SIMATIC NET SINAUT MICRO SC System manual (English) C79000-G8900-C210
SIWAREX MS Device Manual (English) (included with device) none

S7-200 Programmable Controller System Manual (English) 6ES7 298-8FA24-8BHO0
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Finding Your Way

If you are a first-time user of S7-200 Micro PLCs, you should read the entire S7-200
Programmable Controller System Manual. If you are an experienced user, refer to the table of
contents or index to find specific information.

The S7-200 Programmable Controller System Manual is organized according to the following
topics:

1 Chapter 1 (Product Overview) provides an overview of some of the features of the S7-200
family of Micro PLC products.

Chapter 2 (Getting Started) provides a tutorial for creating and downloading a sample
control program to an S7-200.

Chapter 3 (Installing the S7-200) provides the dimensions and basic guidelines for installing
the S7-200 CPU modules and expansion 1/0O modules.

Chapter 4 (PLC Concepts) provides information about the operation of the S7-200.

oo o oo

Chapter 5 (Programming Concepts, Conventions, and Features) provides information about
the features of STEP 7-Micro/WIN, the program editors and types of instructions
(IEC 1131-3 or SIMATIC), S7-200 data types, and guidelines for creating programs.

Chapter 6 (S7-200 Instruction Set) provides descriptions and examples of programming
instructions supported by the S7-200.

U

1 Chapter 7 (Communicating over a Network) provides information for setting up the different
network configurations supported by the S7-200.

1 Chapter 8 (Hardware Troubleshooting Guide and Software Debugging Tools) provides
information for troubleshooting problems with the S7-200 hardware and about the
STEP 7-Micro/WIN features that help you debug your program.

1 Chapter 9 (Open Loop Motion Control with the S7-200) provides information about three
methods of open loop motion control: Pulse Width Modulation, Pulse Train Output, and the
EM 253 Position Control Module.

1 Chapter 10 (Creating a Program for the Modem Module) provides information about the
instructions and wizard used to create a program for the EM 241 Modem module.

U

Chapter 11 (Using the USS Protocol Library to Control a MicroMaster Drive) provides
information about the instructions used to create a control program for a MicroMaster drive.
It also provides information about how to configure the MicroMaster 3 and MicroMaster 4
drives.

Chapter 12 (Using the Modbus Protocol Library) provides information about the instructions
used to create a program that uses the Modbus protocol for communications.

Chapter 13 (Using Recipes) provides information about organizing and loading automation
program recipes in the memory cartridge.

Chapter 14 (Using Data Logs) provides information about storing process measurement
data in the memory cartridge.

O o o o

Chapter 15 (PID Auto-Tune and the PID Tuning Control Panel) provides information about
using these features to greatly enhance the utility and ease of use of the PID function
provided by the S7-200.

1 Appendix A (Technical Specifications) provides the technical information and data sheets
about the S7-200 hardware.

The other appendices provide additional reference information, such as descriptions of the error
codes, descriptions of the Special Memory (SM) area, part numbers for ordering S7-200
equipment, STL instruction execution times, and S7-200CN product information.

In addition to this manual, STEP 7-Micro/WIN provides extensive online help for getting started
with programming the S7-200. Included with the purchase of the STEP 7-Micro/WIN software is a
free documentation CD. On this CD you can find application tips, an electronic version of this
manual and other information.
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Online Help

Help is only a keystroke away! Pressing F1 accesses the extensive online help for

STEP 7-Micro/WIN. The online help includes useful information about getting started with
programming the S7-200, as well as many other topics.

Electronic Manual

An electronic version of this S7-200 System Manual is available on the documentation CD. You
can install the electronic manual onto your computer so that you can easily access the information
in the manual while you are working with the STEP 7-Micro/WIN software.

Programming Tips

The documentation CD includes Programming Tips, a set of application examples with sample
programs. Reviewing or modifying these examples can help you find efficient or innovative
solutions for your own application. You can also find the most current version of Programming Tips
on the S7-200 Internet site.

Recycling and Disposal

Please contact a company certified in the disposal of electronic scrap for environmentally safe
recycling and disposal of your device.

Additional Support

Local Siemens Sales Office or Distributor

For assistance in answering any technical questions, for training on the S7-200 products, or for
ordering S7-200 products, contact your Siemens distributor or sales office. Because your sales
representatives are technically trained and have the most specific knowledge about your
operations, process and industry, as well as about the individual Siemens products that you are
using, they can provide the fastest and most efficient answers to any problems that you might
encounter.

Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the Internet at:

http://www.siemens.com/automation/service&support

where you will find the following:

O www.siemens.com/S7-200 for S7-200 product information

The S7-200 Internet site includes frequently asked questions (FAQs), Programming Tips
(application examples and sample programs), information about newly released products,
and product updates or downloads.

The newsletter, which constantly provides you with up-to-date information on your products.
The right documents via our Search function in Service & Support.

A forum, where users and experts from all over the world exchange their experiences.

I I W

Your local representative for Automation & Drives.

1 Information on field service, repairs, spare parts and more under “Services”.

Technical Services

The highly trained staff of the S7-200 Technical Services center is also available to help you solve
any problems that you might encounter. You can call on them 24 hours a day, 7 days a week.
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A&D Technical Support

Worldwide, available 24 hours a day:

Technical Support

Worldwide (Nuernberg)
Technical Support

24 hours a day, 365 days a year
+49 (180) 5050-222
+49 (180) 5050-223
mailto:adsupport@siemens.com
GMT: +1:00

Phone:
Fax:

Europe / Africa (Nuernberg)
Authorization

Local time: Mon.-Fri.

8:00 AM to 5:00 PM

+49 (180) 5050-222
+49 (180) 5050-223
mailto:adsupport@siemens.com
GMT: +1:00

Phone:
Fax:

United States (Johnson City)

Technical Support and
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone:  +1 (423) 262 2522
+1 (800) 333-7421 (USA only)
Fax: +1 (423) 262 2289

mailto:simatic.hotline@sea.siemens.com
GMT: -5:00

Asia / Australia (Beijing)

Technical Support and
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

+86 1064 7575 75
+86 1064 7474 74

mailto:adsupport.asia@siemens.com
GMT: +8:00

Phone:
Fax:

The languages of the SIMATIC Hotlines and the authorization hotline are generally German and English.

Vii
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Product Overview

The S7-200 series of micro-programmable logic controllers (Micro PLCs) can control a wide
variety of devices to support your automation needs.

The S7-200 monitors inputs and changes outputs as controlled by the user program, which can
include Boolean logic, counting, timing, complex math operations, and communications with other
intelligent devices. The compact design, flexible configuration, and powerful instruction set
combine to make the S7-200 a perfect solution for controlling a wide variety of applications.

In This Chapter

WAt S N 2 oo e e e
ST7-200 CPU ..ottt
S7-200 Expansion Modules . . ... .
STEP 7-Micro/WIN Programming Package
Communications OPLIONS . . .. oottt e e
Display Panels ... ...
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What’s New?

The new features of the SIMATIC S7-200 include two new analog expansion modules:

O EM 231 Analog Input RTD, 4 Inputs
1 EM 231 Analog Input Thermocouple 8 Inputs
1 Appendix H, S7-200CN Products

S7-200 CPU

The S7-200 CPU combines a microprocessor, an integrated power supply, input circuits, and
output circuits in a compact housing to create a powerful Micro PLC. See Figure 1-1. After you
have downloaded your program, the S7-200 contains the logic required to monitor and control the
input and output devices in your application.

1/0 LEDs Access door:

Status LEDs: > / Mode selector switch (RUN/STOP)

System Fault/Diagnostic Analog adjustment potentiometer(s)

EQSUFr(lDIAG) \ ’ : \ Expansion port (for most CPUs)

STOP

Terminal connector
(removable on CPU 224, CPU 224XP
and CPU 226)

Optional cartridge:
Memory Cartridge
Real-time Clock
Battery

Communications port Clip for installation on a standard (DIN) rail

Figure 1-1 S7-200 Micro PLC
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Siemens provides different S7-200 CPU models with a diversity of features and capabilities that
help you create effective solutions for your varied applications. Table 1-1 briefly compares some of
the features of the CPU. For detailed information about a specific CPU, see Appendix A.

Table 1-1 Comparison of the S7-200 CPU Models
CPU 224XP

Feature CPU 221 CPU 222 CPU 224 CPU 224XPsi CPU 226
Physical size (mm) 90 x80x 62 | 90 x 80 x 62 120.5x 80 x 62 | 140 x 80 x 62 190 x 80 x 62
Program memory:
with run mode edit 4096 bytes 4096 bytes 8192 bhytes 12288 bytes 16384 bytes
without run mode edit | 4096 bytes 4096 bytes 12288 bytes 16384 bytes 24576 bytes
Data memory 2048 bytes 2048 bytes 8192 bhytes 10240 bytes 10240 bytes
Memory backup 50 hours 50 hours 100 hours 100 hours 100 hours
typical typical typical typical typical
Local on-board I/0
Digital 6 In/4 Out 8 In/6 Out 14 In/10 Out 14 In/10 Out 24 1n/16 Out
Analog - - - 2 In/1 Out -
Expansion modules 0 modules 2 modules? 7 modules? 7 modules? 7 modules?
High-speed counters
Single phase 4at30kHz | 4at30kHz 6 at 30 kHz 4 at 30 kHz 6 at 30 kHz
2 at 200 kHz
Two phase 2 at 20 kHz 2 at 20 kHz 4 at 20 kHz 3at20 kHz 4 at 20 kHz
1 at 100 kHz
Pulse outputs (DC) 2 at 20 kHz 2 at 20 kHz 2 at 20 kHz 2 at 100 kHz 2 at 20 kHz
Analog adjustments 1 1 2 2 2
Real-time clock Cartridge Cartridge Built-in Built-in Built-in
Communications ports |1 RS-485 |1 RS-485 1 RS-485 2 RS-485 2 RS-485
Floating-point math Yes
Digital I/0 image size 256 (128 in, 128 out)
Boolean execution 0.22 microseconds/instruction
speed

1 You must calculate your power budget to determine how much power (or current) the S7-200 CPU can provide for your configuration. If the CPU
power budget is exceeded, you may not be able to connect the maximum number of modules. See Appendix A for CPU and expansion module
power requirements, and Appendix B to calculate your power budget.
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S7-200 Expansion Modules

To better solve your application requirements, the S7-200 family includes a wide variety of

expansion modules. You can use these expansion modules to add additional functionality to the
S7-200 CPU. Table 1-2 provides a list of the expansion modules that are currently available. For
detailed information about a specific module, see Appendix A.

Table 1-2 S7-200 Expansion Modules
Expansion Type
Modules
Discrete modules
Input 8xDCIn 8 x AC In 16 x DC In
Output 4 x DC Out 4 x Relays 8 x Relay
8 x DC Out 8 x AC Out
Combination 4 xDC In/ 8xDC In/ 16 x DC In/ 32x DC In/
4 x DC Out 8 x DC Out 16 x DC Out 32 x DC Out
4xDClIn/ 8xDCiIn/ 16 x DC In/ 32x DC In/
4 x Relay 8 x Relay 16 x Relay 32 x Relay
Analog modules
Input 4 x Analog In 8 x Analog In 4 x Thermocouple In | 8 x Thermocouple In
2xRTD In 4x RTD In
Output 2 x Analog Out 4 x Analog Out
Combination 4 x Analog In

Intelligent modules

Other modules

4 x Analog Out

Position

Ethernet

AS-Interface

Modem
Ethernet IT

SIWAREX MS1

PROFIBUS-DP

1 Detailed information not included in Appendix A. Please refer to your module documentation.
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STEP 7-Micro/WIN Programming Package

The STEP 7-Micro/WIN programming package provides a user-friendly environment to develop,
edit, and monitor the logic needed to control your application. STEP 7-Micro/WIN provides three
program editors for convenience and efficiency in developing the control program for your
application. To help you find the information you need, STEP 7-Micro/WIN provides an extensive
online help system and a documentation CD that contains an electronic version of this manual,
application tips, and other useful information.

Computer Requirements

STEP 7-Micro/WIN runs on either a personal computer or a Siemens programming device, such
as a PG 760. Your computer or programming device should meet the following minimum
requirements:

1 Operating system:
Windows 2000, Windows XP, Vista

1 Atleast 350M bytes of free hard
disk space

1 Mouse (recommended)

Figure 1-2  STEP 7-Micro/WIN

Installing STEP 7-Micro/WIN

Insert the STEP 7-Micro/WIN CD into the CD-ROM drive of your computer. The installation wizard
starts automatically and prompts you through the installation process. Refer to the Readme file for
more information about installing STEP 7-Micro/WIN.

Tip
@ To install STEP 7-Micro/WIN on a Windows 2000, Windows XP, or Windows Vista operating
system, you must log in with Administrator privileges.

Communications Options

Siemens provides two programming options for connecting your computer to your S7-200: a direct
connection with a PPI Multi-Master cable, or a Communications Processor (CP) card with an MPI
cable.

The PPl Multi-Master programming cable is the most common and economical method of
connecting your computer to the S7-200. This cable connects the communications port of the
S7-200 to the serial communications of your computer. The PPl Multi-Master programming cable
can also be used to connect other communications devices to the S7-200.
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Display Panels

Text Display Units

The Text Display (TD) is a display device that can be connected to the S7-200. Using the Text
Display wizard, you can easily program your S7-200 to display text messages and other data
pertaining to your application.

The TD device provides a low cost interface to your application by allowing you to view, monitor,
and change the process variables pertaining to your application.

The S7-200 product family provides four TD devices:

0 The TD100C has a 4-line text TD 100C
display with 2 font choices.

(1 The TD 200C has a 2-line text T
display with 20 characters per line B
for a total of 40 characters.

TD200C /
[ The TD 200 has a faceplate which / )
provides four keys with predefined, 'ﬁ'l’t‘ﬁ_‘u’_i]'ﬁLjn-_g'[,-ﬂ[1-“1-1-,-5-“““. /

1ay1"a.1‘nxa_\.Ku1\.’51'\'.15«.-.5\%1\\1‘@1}

set-bit functions and allows up to
Text Display eight set-bit functions.

[J The TD400C can have a 2- or
4-line text display depending on Figure 1-3  Text Display Units
your font and character choice.

For more information about the Text Display Units, refer to the SIMATIC Text Display (TD) User
Manual on the STEP 7-Micro/WIN docuCD.

The Text Display wizard in STEP 7-Micro/WIN helps you configure Text Display messages
quickly and easily. To start the Text Display wizard, select the Tools > Text Display Wizard menu
command.

Operator and Touch Panel Displays

The OP 73micro and TP 177micro
panels are tailored to applications with
SIMATIC S7-200 Micro PLC and provide
operating and monitoring functions for
small-scale machines and plants. Short
configuration and commissioning times,
and their configuration in WinCC flexible
form the highlights of these panels. In
addition, these panels support up to 32
configuration languages and five online
languages, including the Asian and
Cyrillic character sets.

The mounting dimensions of the
Operator Panel OP 73micro with its
graphical 3” display unit are compatible
with OP3 and TD 200.

Touch Panel TP 177micro replaces the
Touch Panel TP 070/TP 170micro. It can

be mounted vertically to accommodate
additional applications. This feature
enables its use even when space is Figure 1-4  Operator and Touch Panel Displays
restricted.



Getting Started

STEP 7-Micro/WIN makes it easy for you to program your S7-200. In just a few short steps using
a simple example, you can learn how to connect, program, and run your S7-200.

All you need for this example is a PPI Multi-Master cable, an S7-200 CPU, and a programming
device running the STEP 7-Micro/WIN programming software.

In This Chapter

Connecting the S7-200 CPU .. ... e 8
Creating a Sample Program . . ... . 10
Downloading the Sample Program . .......... .. 14
Placing the S7-200 in RUN Mode .. ... .. i e 14
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Connecting the S7-200 CPU

Connecting your S7-200 is easy. For this example, you only need to connect power to your
S7-200 CPU and then connect the communications cable between your programming device and
the S7-200 CPU.

Connecting Power to the S7-200 CPU

The first step is to connect the S7-200 to a power source. Figure 2-1 shows the wiring
connections for either a DC or an AC model of the S7-200 CPU.

Before you install or remove any electrical device, ensure that the power to that equipment has
been turned off. Always follow appropriate safety precautions and ensure that power to the
S7-200 is disabled before attempting to install or remove the S7-200.

Warning

' E Attempts to install or wire the S7-200 or related equipment with power applied could cause

* electric shock or faulty operation of equipment. Failure to disable all power to the S7-200 and
related equipment during installation or removal procedures could result in death or serious
injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled
before attempting to install or remove the S7-200 or related equipment.

4 VDC 85 to 265 VAC

Jf—‘
ﬁ@@@@

DC Installation AC Installation

Figure 2-1 Connecting Power to the S7-200 CPU
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Connecting the RS-232/PPI Multi-Master Cable
Figure 2-2 shows an RS-232/PPI [ P .
Multi-Master cable connecting the Drecz/giézmmmg
S7-200 to the programming device. To
connect the cable:
S7-200
1. Connect the RS-232 connector

(marked “PC”) of the RS-232/PPI
Multi-Master cable to the
communications port of the
programming device. (For this
example, connectto COM 1.)

2. Connect the RS-485 connector
(marked “PPI") of the RS-232/PPI
Multi-Master cable to Port 0 or
Port 1 of the S7-200.

3. Ensure that the DIP switches of
the RS-232/PPI Multi-Master cable
are set as shown in Figure 2-2.

Tip

"

RS-232/PPI
Multi-Master Cable

$1-0n
10 - Off

o] Jafa] ufafs

123456 7 8]

Figure 2-2  Connecting the RS-232/PPI Multi-Master Cable

Examples in this manual use the RS-232/PPI Multi-Master cable. The RS-232/PPI Multi-Master

cable replaces the previous PC/PPI cable. A USB/PPI Multi-Master cable is also available.

Refer to Appendix E for order numbers.

Starting STEP 7-Micro/WIN

Click on the STEP 7-Micro/WIN icon to
open a new project. Figure 2-3 shows a
new project.

Notice the navigation bar. You can use
the icons on the navigation bar to open
elements of the STEP 7-Micro/WIN
project.

Click on the Communications icon in the
navigation bar to display the
Communications dialog box. You use
this dialog box to set up the
communications for STEP 7-Micro/WIN.

Navigation bar

Communications icon

—

Figure 2-3  New STEP 7-Micro/WIN Project
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Verifying the Communications Parameters for STEP 7-Micro/WIN

The example project uses the default settings for STEP 7-Micro/WIN and the RS-232/PPI
Multi-Master cable. To verify these settings:

1. Verify that the address of the
PC/PPI cable in the Lot " EE%PP\ sabelPF]
Communications dialog box is set Femete - ) Dot Cick
t0 0 T 5 toFiefresh

2. Verify that the interface for the 7 Save sttings wil prciect
network parameter is set for ~Netuak
PC/PPI cable(COMl). Inteiface: PCAPPI cable(COM 1)

Protocal PRI
3. Verify that the transmission rate is e 1o
Set to 96 kbps Highest Station (HSA): 31
7 Supparts muliple masters
If you need to change your  Tiensrission Fa s
. . . Baud Rate: ps
gohmn:un?atlons parameter settings, see T
apter 7.

Figure 2-4  Verifying the Communications Parameters

Establishing Communications with the S7-200

Use the Communications dialog box to connect with your S7-200 CPU:

1. Double-click the refresh icon in the
Communications dialog box. e . T 7 e
STEP 7-Micro/WIN searches for e o d 3 Dol
the S7-200 station and displays a
CPU icon for the connected [T
S7-200 station. Netwark
2. Select the S7-200 and click OK. e S

Mode: -kt
Highesst Station (HEA) 3

If STEP 7-Micro/WIN does not find your
S7-200 CPU, check the settings for the _—
communications parameters and repeat Bowat Rte 36 kbps
these Steps_ ™ Search all baud rates

Set PGIPC Interface o8 GCancel

7 Supports mutiple masters

After you have established
communications with the S7-200, you
are ready to create and download the Figure 2-5  Establishing Communications to the S7-200
example program.

Creating a Sample Program

10

Entering this example of a control program will help you understand how easy it is to use
STEP 7-Micro/WIN. This program uses six instructions in three networks to create a very simple,
self-starting timer that resets itself.

For this example, you use the Ladder (LAD) editor to enter the instructions for the program. The
following example shows the complete program in both LAD and Statement List (STL). The
network comments in the STL program explain the logic for each network. The timing diagram
shows the operation of the program.
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Example: Sample Program for getting started with STEP 7-Micro/WIN

Network 1 Network 1 /110 ms timer T33 times out after
MO0 133 //(100 x 10 ms = 1 s) M0.0 pulse is
— /v ™ /I too fast to monitor with Status view.
A00dPT__ 10me LDN MO0.0
TON T33, +100
Network 2 /IComparison becomes true at a
[Irate that is visible with
Network 2 /IStatus view. Turn on Q0.0 after
133 Lo /(40 x 10 ms = 0.4 s), for a
A 1 40% OFF/60% ON waveform,
LDW>= T33, +40
Network 3 = QOO
33 MO0 Network 3 /IT33 (bit) pulse too fast to monitor with
— —C ) /[Status view. Reset the timer through
/IMO0.0 after the (100 x 10 ms =1 s) period.
LD T33
= MO0.0

Timing Diagram
current = 100

current = 40 ==

T33 (current)
]
[}
[]

T33 (bit)

0.4s; 0.6s !

MO0.0

Q0.0—

Opening the Program Editor

Click on the Program Block icon to open
the program editor. See Figure 2-6.

Notice the instruction tree and the
program editor. You use the instruction
tree to insert the LAD instructions into
the networks of the program editor by
dragging and dropping the instructions
from the instruction tree to the networks.

The toolbar icons provide shortcuts to
the menu commands.

After you enter and save the program,
you can download the program to the
S7-200.

Figure 2-6

Program editor

Instruction tree

STEP 7-Micro/WIN Window

11
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Entering Network 1: Starting the Timer

When MO0.0 is off (0), this contact turns on and provides power flow to start the timer. To enter the
contact for M0.0:

1.

Either double-click the Bit Logic
icon or click on the plus sign (+) to
display the bit logic instructions.

Select the Normally Closed
contact.

Hold down the left mouse button
and drag the contact onto the first
network.

Click on the “???” above the

contact and enter the following
address: M0.0

Press the Return key to enter the

Figure 2-7  Network 1
address for the contact. 9

To enter the timer instruction for T33:

o > 0w np e

7.

Double-click the Timers icon to display the timer instructions.

Select the TON (On-Delay Timer).

Hold down the left mouse button and drag the timer onto the first network.

Click on the “???” above the timer box and enter the following timer number: T33

Press the Return key to enter the timer number and to move the focus to the preset time
(PT) parameter.

Enter the following value for the preset time: 100

Press the Return key to enter the value.

Entering Network 2: Turning the Output On

When the timer value for T33 is greater than or equal to 40 (40 times 10 milliseconds, or 0.4
seconds), the contact provides power flow to turn on output Q0.0 of the S7-200. To enter the
Compare instruction:

1.

Double-click the Compare icon to display the compare instructions. Select the >=I
instruction (Greater-Than-Or-Equal-To-Integer ).

Hold down the left mouse button
and drag the compare instruction
onto the second network.

Click on the “???" above the
contact and enter the address for
the timer value: T33

Press the Return key to enter the
timer number and to move the
focus to the other value to be
compared with the timer value.

Enter the following value to be
compared with the timer value: 40

Press the Return key to enter the Figure 2-8  Network 2
value.

To enter the instruction for turning on output QO0.0:

1
2
3.
4

Double-click the Bit Logic icon to display the bit logic instructions and select the output coil.
Hold down the left mouse button and drag the coil onto the second network.
Click on the “??7?” above the coil and enter the following address: Q0.0

Press the Return key to enter the address for the coil.
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Entering Network 3: Resetting the Timer

When the timer reaches the preset value (100) and turns the timer bit on, the contact for T33 turns
on. Power flow from this contact turns on the M0.0 memory location. Because the timer is enabled
by a Normally Closed contact for M0.0, changing the state of M0.0 from off (0) to on (1) resets the

timer.

To enter the contact for the timer bit of

T33:

1.

Select the Normally Open contact
from the bit logic instructions.

Hold down the left mouse button
and drag the contact onto the third
network.

Click on the “???"” above the
contact and enter the address of
the timer bit: T33

Press the Return key to enter the
address for the contact.

To enter the coll for turning on M0.0:

1
2
3.
4

Figure 2-9  Network 3

Select the output coil from the bit logic instructions.

Hold down the left mouse button and drag the output coil onto the third network.

Double-click the “???” above the coil and enter the following address: M0.0

Press the Return key to enter the address for the coil.

Saving the Sample Project

After entering the three networks of instructions, you have finished entering the program. When
you save the program, you create a project that includes the S7-200 CPU type and other
parameters. To save the project:

1.

3.

Select the File > Save As menu
command from the menu bar.

Enter a name for the project in the
Save As dialog box.

Click OK to save the project.

After saving the project, you can
download the program to the S7-200.

Save As

Save in |@ Projects j &= cF E-

File name: |EettmgSIarted

Save as ype: |Froect Fiie i) =l

Save I
Cancel
v

Figure 2-10 Saving the Example Program

13
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Downloading the Sample Program

¥

Tip

Each STEP 7-Micro/WIN project is associated with a CPU type (CPU 221, CPU 222, CPU 224,
CPU 224XP, or CPU 226). If the project type does not match the CPU to which you are
connected, STEP 7-Micro/WIN indicates a mismatch and prompts you to take an action. If this
occurs, choose “Continue Download” for this example.

1. Click the Download icon on the
toolbar or select the
File > Download menu command
to download the program. See
Figure 2-11.

2. Click OK to download the elements
of the program to the S7-200.

il

If your S7-200 is in RUN mode, a dialog
box prompts you to place the S7-200 in
STOP mode. Click Yes to place the

S7-200 into STOP mode. Figure 2-11 Downloading the Program

Placing the S7-200 in RUN Mode

14

For STEP 7-Micro/WIN to place the S7-200 CPU in RUN mode, the mode switch of the S7-200
must be set to TERM or RUN. When you place the S7-200 in RUN mode, the S7-200 executes
the program:

1. Click the RUN icon on the toolbar RUN E
or select the PLC > RUN menu P
command. @ Place the PLC in RUN made?

2. Click OK to change the operating
mode of the S7-200. Yor Mo |

When the S7-200 goes to RUN mode,

the output LED for Q0.0 turns on and off 5,06 2,12 Placing the S7-200 in RUN Mode
as the S7-200 executes the program.

Congratulations! You have just completed your first S7-200 program.

You can monitor the program by selecting the Debug > Program Status menu command.
STEP 7-Micro/WIN displays the values for the instructions. To stop the program, place the S7-200
in STOP mode by clicking the STOP icon or by selecting the PLC > STOP menu command.



Installing the S7-200

The S7-200 equipment is designed to be easy to install. You can use the mounting holes to attach
the modules to a panel, or you can use the built-in clips to mount the modules onto a standard
(DIN) rail. The small size of the S7-200 allows you to make efficient use of space.

This chapter provides guidelines for installing and wiring your S7-200 system.

In This Chapter

Guidelines for Installing S7-200 DEVICES . .. ..ottt e 16
Installing and Removing the S7-200 Modules ......... ... ... . 17
Guidelines for Grounding and Wiring . ... ... .ot 20

15
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Guidelines for Installing S7-200 Devices

You can install an S7-200 either on a panel or on a standard rail, and you can orient the S7-200
either horizontally or vertically.

Warning
' The SIMATIC S7-200 PLCs are Open Type Controllers. It is required that you install the S7-200
. in a housing, cabinet, or electric control room. Entry to the housing, cabinet, or electric control
room should be limited to authorized personnel.

Failure to follow these installation requirements could result in death or serious injury to
personnel, and/or damage to equipment.

Always follow these requirements when installing S7-200 PLCs.

Separate the S7-200 Devices from Heat, High Voltage, and Electrical
Noise
As a general rule for laying out the devices of your system, always separate the devices that

generate high voltage and high electrical noise from the low-voltage, logic-type devices such as
the S7-200.

When configuring the layout of the S7-200 inside your panel, consider the heat-generating
devices and locate the electronic-type devices in the cooler areas of your cabinet. Operating any
electronic device in a high-temperature environment will reduce the time to failure.

Consider also the routing of the wiring for the devices in the panel. Avoid placing low voltage
signal wires and communications cables in the same tray with AC power wiring and high-energy,
rapidly-switched DC wiring.

Provide Adequate Clearance for Cooling and Wiring

S7-200 devices are designed for natural convection cooling. For proper cooling, you must provide
a clearance of at least 25 mm above and below the devices. Also, allow at least 75 mm of depth.

Caution

For vertical mounting, the maximum allowable ambient temperature is reduced by
10 degrees C. Mount the S7-200 CPU below any expansion modules.

When planning your layout for the S7-200 system, allow enough clearance for the wiring and

communications cable connections. For additional flexibility in configuring the layout of the S7-200
system, use the 1/0O expansion cable.

Clearance 35mm
e . P .

sl l j_ 1 mm
 S— : I e | K
- | N [ V%I ]
i E@ R Ht — ﬂ[ | 5 | ! DIN Rail
25 mm Lo Eﬁ - 7% 1 ‘ E E ‘
\ “=I il
‘ ‘ 75 mm
iR
RN
o SO oo Muntng
e ||E nnnnnn - HE nnnnnn IEE Vertlcal Panel \
e P e ; Mounting
W B BT
... = Side View

Horizontal DIN Rail Mounting with Optional
Expansion Cable (limit one per system)

Figure 3-1 Mounting Methods, Orientation, and Clearance

16
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Power Budget

All S7-200 CPUs have an internal power supply that provides power for the CPU, the expansion
modules, and other 24 VDC user power requirements.

The S7-200 CPU provides the 5 VDC logic power needed for any expansion in your system. Pay
careful attention to your system configuration to ensure that your CPU can supply the 5V power
required by your selected expansion modules. If your configuration requires more power than the
CPU can supply, you must remove a module or select a CPU with more power capability. Refer to
Appendix A for information about the 5 VDC logic budget supplied by your S7-200 CPU and the

5 VDC power requirements of the expansion modules. Use Appendix B as a guide for determining
how much power (or current) the CPU can provide for your configuration.

All S7-200 CPUs also provide a 24 VDC sensor supply that can supply 24 VDC for input points,
for relay coil power on the expansion modules, or for other requirements. If your power
requirements exceed the budget of the sensor supply, then you must add an external 24 VDC
power supply to your system. Refer to Appendix A for the 24 VDC sensor supply power budget for
your particular S7-200 CPU.

If you require an external 24 VDC power supply, ensure that the power supply is not connected in
parallel with the sensor supply of the S7-200 CPU. For improved electrical noise protection, it is
recommended that the commons (M) of the different power supplies be connected.

Warning
' Connecting an external 24 VDC power supply in parallel with the S7-200 24 VDC sensor supply
* can result in a conflict between the two supplies as each seeks to establish its own preferred
output voltage level.

The result of this conflict can be shortened lifetime or immediate failure of one or both power
supplies, with consequent unpredictable operation of the PLC system. Unpredictable operation
could result in death or serious injury to personnel, and/or damage to equipment.

The S7-200 DC sensor supply and any external power supply should provide power to different
points.

Installing and Removing the S7-200 Modules

The S7-200 can be easily installed on a standard DIN rail or on a panel.

Prerequisites

Before you install or remove any electrical device, ensure that the power to that equipment has
been turned off. Also, ensure that the power to any related equipment has been turned off.

Warning
' Attempts to install or remove S7-200 or related equipment with the power applied could cause
* electric shock or faulty operation of equipment.

Failure to disable all power to the S7-200 and related equipment during installation or removal
procedures could result in death or serious injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled
before attempting to install or remove S7-200 CPUs or related equipment.

Always ensure that whenever you replace or install an S7-200 device you use the correct module
or equivalent device.

Warning
' E If you install an incorrect module, the program in the S7-200 could function unpredictably.
L ]

Failure to replace an S7-200 device with the same model, orientation, or order could result in
death or serious injury to personnel, and/or damage to equipment.

Replace an S7-200 device with the same model, and be sure to orient and position it correctly.

17
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Mounting Dimensions

The S7-200 CPUs and expansion modules include mounting holes to facilitate installation on
panels. Refer to Table 3-1 for the mounting dimensions.

Table 3-1 Mounting Dimensions

_.‘ -— 9.5 mm* * Minimum spacing

between modules

4mm T‘ A ;T when hard-mounted
_¢ B B ,‘
f & & Mounting
\ ] 0 )| holes (M4
E | oooooooo ocooooooo ! I ooooopon Y or No. 8)
96 mm 88 mm 80 mm > .
(®)
@ 1 [={=[=]=f={=]={=]=]={=]={=]={=]=} i 1 oooaoang f
U | 1}
% o
BN s YR
_T 4 mm —>| |<— B
4 mm —— A ——™
S7-200 Module Width A Width B
CPU 221 and CPU 222 90 mm 82 mm
CPU 224 120.5 mm | 112.5 mm
CPU 224XP, CPU 224XPsi 140 mm 132 mm
CPU 226 196 mm 188 mm
Expansion modules: 4- and 8-point DC and Relay 1/0 (8, 4Q, 8Q, 41/4Q) 46 mm 38 mm
and Analog Out (2 AQ)
Expansion modules: 16-point digital I/O (161, 81/8Q), Analog I/O (4Al, 8Al, 4AQ, 71.2mm  63.2mm

4A1/1AQ), RTD, Thermocouple, PROFIBUS, Ethernet,
Internet, AS-Interface, 8-point AC (8l and 8Q), Position, and

Modem
Expansion modules: 32-point digital 1/0 (161/16Q) 137.3 mm | 129.3 mm
Expansion modules: 64-point digital I/O (321/32Q) 196 mm 188 mm

Installing a CPU or Expansion Module
Installing the S7-200 is easy! Just follow these steps.

Panel Mounting

1.

Locate, drill, and tap the mounting holes (M4 or American Standard number 8), using the
dimensions in Table 3-1.

Secure the module(s) to the panel, using the appropriate screws.

If you are using an expansion module, connect the expansion module ribbon cable into the
expansion port connector under the access door.

DIN Rail Mounting

1.
2.
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Secure the rail to the mounting panel every 75 mm.

Snap open the DIN clip (located on the bottom of the module) and hook the back of the
module onto the DIN rail.

If you are using an expansion module, connect the expansion module ribbon cable into the
expansion port connector under the access door.

Rotate the module down to the DIN rail and snap the clip closed. Carefully check that the
clip has fastened the module securely onto the rail. To avoid damage to the module, press
on the tab of the mounting hole instead of pressing directly on the front of the module.
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Tip
@ Using DIN rail stops could be helpful if your S7-200 is in an environment with high vibration
potential or if the S7-200 has been installed vertically.

If your system is in a high-vibration environment, then panel-mounting the S7-200 will provide a
greater level of vibration protection.

Removing a CPU or Expansion Module
To remove an S7-200 CPU or expansion module, follow these steps:

1.
2.

Remove power from the S7-200.

Disconnect all the wiring and cabling that is attached to the module. Most S7-200 CPU and
expansion modules have removable connectors to make this job easier.

If you have expansion modules connected to the unit that you are removing, open the
access cover door and disconnect the expansion module ribbon cable from the adjacent
modules.

Unscrew the mounting screws or snap open the DIN clip.

Remove the module.

Removing and Reinstalling the Terminal Block Connector

Most S7-200 modules have removable connectors to make installing and replacing the module
easy. Refer to Appendix A to determine whether your S7-200 module has removable connectors.
You can order an optional fan-out connector for modules that do not have removable connectors.
See Appendix E for order numbers.

To Remove the Connector

1.
2.
3.

Open the connector door to gain access to the connector.
Insert a small screwdriver in the notch in the middle of the connector.

Remove the terminal connector by prying the screwdriver away from the S7-200 housing.
See Figure 3-2.

Figure 3-2 Removing the Connector

To Reinstall the Connector

1.
2.

Open the connector door.

Align the connector with the pins on the unit and align the wiring edge of the connector
inside the rim of the connector base.

Press down firmly to rotate the connector until it snaps into place. Check carefully to ensure
that the connector is properly aligned and fully engaged.
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Guidelines for Grounding and Wiring

Proper grounding and wiring of all electrical equipment is important to help ensure the optimum
operation of your system and to provide additional electrical noise protection for your application
and the S7-200.

Prerequisites

N

N

Gu
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Before you ground or install wiring to any electrical device, ensure that the power to that
equipment has been turned off. Also, ensure that the power to any related equipment has been
turned off.

Ensure that you follow all applicable electrical codes when wiring the S7-200 and related
equipment. Install and operate all equipment according to all applicable national and local
standards. Contact your local authorities to determine which codes and standards apply to your
specific case.

Warning

Attempts to install or wire the S7-200 or related equipment with power applied could cause
electric shock or faulty operation of equipment. Failure to disable all power to the S7-200 and
related equipment during installation or removal procedures could result in death or serious
injury to personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200 is disabled
before attempting to install or remove the S7-200 or related equipment.

Always take safety into consideration as you design the grounding and wiring of your S7-200
system. Electronic control devices, such as the S7-200, can fail and can cause unexpected
operation of the equipment that is being controlled or monitored. For this reason, you should
implement safeguards that are independent of the S7-200 to protect against possible personal
injury or equipment damage.

Warning

Control devices can fail in an unsafe condition, resulting in unexpected operation of controlled
equipment. Such unexpected operations could result in death or serious injury to personnel,
and/or damage to equipment.

Use an emergency stop function, electromechanical overrides, or other redundant safeguards
that are independent of the S7-200.

idelines for Isolation

S7-200 AC power supply boundaries and I/O boundaries to AC circuits have been designed and
approved to provide safe separation between AC line voltages and low voltage circuits. These
boundaries include double or reinforced insulation, or basic plus supplementary insulation,
according to various standards. Components which cross these boundaries such as optical
couplers, capacitors, transformers, and relays have been approved as providing safe separation.
Isolation boundaries which meet these requirements have been identified in S7-200 product data
sheets as having 1500VAC or greater isolation. This designation is based on a routine factory test
of (2Ue + 1000VAC ) or equivalent according to approved methods. S7-200 safe separation
boundaries have been type tested to 4242 VDC.

The sensor supply output, communications circuits, and internal logic circuits of an S7-200 with
included AC power supply are sourced as SELV (safety extra-low voltage) according to EN
61131-2. These circuits become PELV (protective extra-low voltage) if the sensor supply M, or
any other non-isolated M connection to the S7-200 is connected to ground. Other S7-200 M
connections which may ground reference the low voltage are designated as not isolated to logic
on specific product data sheets. Examples are RS485 communications port M, analog 1/0O M, and
relay coil power M.

To maintain the SELV / PELV character of the S7-200 low voltage circuits, external connections to
communications ports, analog circuits, and all 24V nominal power supply and I/O circuits must be
powered from approved sources that meet the requirements of SELV, PELYV, Class 2, Limited
Voltage, or Limited Power according to various standards.
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Warning

Use of non-isolated or single insulation supplies to supply low voltage circuits from an AC line
can result in hazardous voltages appearing on circuits that are expected to be touch safe, such
as communications circuits and low voltage sensor wiring.

Such unexpected high voltages could result in death or serious injury to personnel, and/or
damage to equipment.

Only use high voltage to low voltage power converters that are approved as sources of touch
safe, limited voltage circuits.

idelines for Grounding the S7-200

The best way to ground your application is to ensure that all the common and ground connections
of your S7-200 and related equipment are grounded to a single point. This single point should be
connected directly to the earth ground for your system.

For improved electrical noise protection, it is recommended that all DC common returns be
connected to the same single-point earth ground. Connect the 24 VDC sensor supply common
(M) to earth ground.

All ground wires should be as short as possible and should use a large wire size, such as 2 mm?2
(14 AWG).

When locating grounds, remember to consider safety grounding requirements and the proper
operation of protective interrupting devices.

idelines for Wiring the S7-200

When designing the wiring for your S7-200, provide a single disconnect switch that simultaneously
removes power from the S7-200 CPU power supply, from all input circuits, and from all output
circuits. Provide overcurrent protection, such as a fuse or circuit breaker, to limit fault currents on
supply wiring. You might want to provide additional protection by placing a fuse or other current
limit in each output circuit.

Install appropriate surge suppression devices for any wiring that could be subject to lightning
surges.

Avoid placing low-voltage signal wires and communications cables in the same wire tray with AC
wires and high-energy, rapidly switched DC wires. Always route wires in pairs, with the neutral or
common wire paired with the hot or signal-carrying wire.

Use the shortest wire possible and ensure that the wire is sized properly to carry the required
current. The connector accepts wire sizes from 2 mm2 to 0.3 mm2 (14 AWG to 22 AWG). Use
shielded wires for optimum protection against electrical noise. Typically, grounding the shield at
the S7-200 gives the best results.

When wiring input circuits that are powered by an external power supply, include an overcurrent
protection device in that circuit. External protection is not necessary for circuits that are powered
by the 24 VDC sensor supply from the S7-200 because the sensor supply is already
current-limited.

Most S7-200 modules have removable connectors for user wiring. (Refer to Appendix A to
determine if your module has removable connectors.) To prevent loose connections, ensure that
the connector is seated securely and that the wire is installed securely into the connector. To avoid
damaging the connector, be careful that you do not over-tighten the screws. The maximum torque
for the connector screw is 0.56 N-m (5 inch-pounds).

To help prevent unwanted current flows in your installation, the S7-200 provides isolation
boundaries at certain points. When you plan the wiring for your system, you should consider these
isolation boundaries. Refer to Appendix A for the amount of isolation provided and the location of
the isolation boundaries. Isolation boundaries rated less than 1500 VAC must not be depended on
as safety boundaries.

Tip
For a communications network, the maximum length of the communications cable is 50 m

without using a repeater. The communications port on the S7-200 is non-isolated. Refer to
Chapter 7 for more information.
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Guidelines for Lamp Loads
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Guidelines for Inductive Loads

You should equip inductive loads with suppression circuits to limit voltage rise when the control
output turns off. Suppression circuits protect your outputs from premature failure due to high
inductive switching currents. In addition, suppression circuits limit the electrical noise generated
when switching inductive loads.

Tip
The effectiveness of a given suppression circuit depends on the application, and you must verify

it for your particular use. Always ensure that all components used in your suppression circuit are
rated for use in the application.

DC Outputs and Relays That Control DC Loads

The DC outputs have internal protection that is adequate for most applications. Since the relays
can be used for either a DC or an AC load, internal protection is not provided.

Figure 3-3 shows a sample suppression A B (optional)
circuit for a DC load. In most
applications, the addition of a diode (A)
across the inductive load is suitable, but ., B ra o o
if your application requires faster turn-off ~ Point

times, then the addition of a Zener diode DC Inductive Load

(B) is recommended. Be sure to size

A - 11N4001 diode or equivalent

your Zener diode properly for the amount

of current in your output circuit. Figure 3-3  Suppression Circuit for a DC Load

AC Outputs and Relays That Control AC Loads

The AC outputs have internal protection that is adequate for most applications. Since the relays
can be used for either a DC or an AC load, internal protection is not provided.

Figure 3-4 shows a sample suppression duF 10010120 Q
circuit for an AC load. When you use a — ——W\——

relay or AC output to switch 115 V/230 MOV

VAC loads, place resistor/capacitor

networks across the AC load as shown @

in this figure. You can also use a metal

oxide varistor (MOV) to limit peak Output _m__@_
voltage. Ensure that the working voltage Point AC Inductive Load

of the MOV is at least 20% greater than

the nominal line voltage. Figure 3-4  Suppression Circuit for an AC Load

Warning

When relay expansion modules are used to switch AC inductive loads, the external
resistor/capacitor noise suppression circuit must be placed across the AC load to prevent
unexpected machine or process operation. See Figure 3-4.

Lamp loads are damaging to relay contacts because of the high turn-on surge current. This surge
current will nominally be 10 to 15 times the steady state current for a Tungsten lamp. A
replaceable interposing relay or surge limiter is recommended for lamp loads that will be switched
a large number of times during the lifetime of the application.
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The basic function of the S7-200 is to monitor field inputs and, based on your control logic, turn on
or off field output devices. This chapter explains the concepts used to execute your program, the
various types of memory used, and how that memory is retained.

In This Chapter

Understanding How the S7-200 Executes Your Control Logic . ......................... 24
Accessing the Data of the S7-200 .. ... .. . 27
Understanding How the S7-200 Saves and RestoresData . .............. ... ..o ... 36

Selecting the Operating Mode forthe S7-200 CPU ... ... ... it 40
Using the S7-200 EXPIOrer . ... e e e 41
Features of the S7-200 . .. ... .. it 41
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Understanding How the S7-200 Executes Your Control Logic

The S7-200 continuously cycles through the control logic in your program, reading and writing
data.

The S7-200 Relates Your Program to the Physical Inputs and Outputs

The basic operation of the S7-200 is very simple: Start PB E_stop M Starter
[ The S7-200 reads the status of the inputs. /!,} 1 F ®)
~
1 The program that is stored in the S7-200 uses Im_starter P Motor
these inputs to evaluate the control logic. As [ -
the program runs, the S7-200 updates the [ P P
data. | ~ |
- Output  |°oe
1 The S7-200 writes the data to the outputs. Motor Starter

Figure 4-1 shows a simple diagram of how an NS
electrical relay diagram relates to the S7-200. In this ‘,
example, the state of the switch for starting the
motor is combined with the states of other inputs.
The calculations of these states then determine the
state for the output that goes to the actuator which Figure 4-1  Controlling Inputs and Outputs
starts the motor.

s EEE— ~,1
Input =
.ml Start / Stop Switch

The S7-200 Executes Its Tasks in a Scan Cycle

The S7-200 executes a series of tasks repetitively. This cyclical execution of tasks is called the
scan cycle. As shown in Figure 4-2, the S7-200 performs most or all of the following tasks during a
scan cycle:

1 Reading the inputs: The S7-200 copies the
state of the physical inputs to the Writes to the outputs

process-image input register.
1 Executing the control logic in the program: OIS

The S7-200 executes the instructions of the / \
V

program and stores the values in the various
Process any
1 Processing any communications requests:

>
The S7-200 performs any tasks required for '::l B e FemEy
communications.

y N)
1 Executing the CPU self-test diagnostics: The SR ~i ~|1

S7-200 ensures that the firmware, the | Reads the inputs | Q)
program memory, and any expansion
modules are working properly.

1 Writing to theT outputs: The val_ues stored_in Figure 42  S7-200 Scan Cycle
the process-image output register are written
to the physical outputs.

The execution of the user program is dependent upon whether the S7-200 is in STOP mode or in
RUN mode. In RUN mode, your program is executed; in STOP mode, your program is not
executed.
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Reading the Inputs

Digital inputs: Each scan cycle begins by reading the current value of the digital inputs and then
writing these values to the process-image input register.

Analog inputs: The S7-200 does not update analog inputs from expansion modules as part of the
normal scan cycle unless filtering of analog inputs is enabled. An analog filter is provided to allow
you to have a more stable signal. You can enable the analog filter for each analog input point.

When analog input filtering is enabled for an analog input, the S7-200 updates that analog input
once per scan cycle, performs the filtering function, and stores the filtered value internally. The
filtered value is then supplied each time your program accesses the analog input.

When analog filtering is not enabled, the S7-200 reads the value of the analog input from
expansion modules each time your program accesses the analog input.

Analog inputs AIW0 and AIW2 included on the CPU 224XP are updated every scan with the most
recent result from the analog-to-digital converter. This converter is an averaging type (sigma-delta)
and those values will usually not need software filtering.

Tip
Analog input filtering is provided to allow you to have a more stable analog value. Use the

analog input filter for applications where the input signal varies slowly with time. If the signal is a
high-speed signal, then you should not enable the analog filter.

Do not use the analog filter with modules that pass digital information or alarm indications in the
analog words. Always disable analog filtering for RTD, Thermocouple, and AS-Interface Master
modules.

Executing the Program

During the execution phase of the scan cycle, the S7-200 executes your program, starting with the
first instruction and proceeding to the end instruction. The immediate 1/O instructions give you
immediate access to inputs and outputs during the execution of either the program or an interrupt
routine.

If you use subroutines in your program, the subroutines are stored as part of the program. The
subroutines are executed when they are called by the main program, by another subroutine, or by
an interrupt routine. Subroutine nesting depth is 8 from the main and 1 from an interrupt routine.

If you use interrupts in your program, the interrupt routines that are associated with the interrupt
events are stored as part of the program. The interrupt routines are not executed as part of the
normal scan cycle, but are executed when the interrupt event occurs (which could be at any point
in the scan cycle).

Local memory is reserved for each of eleven entities: one main, eight subroutine nesting levels
when initiated from the main, one interrupt, and one subroutine nesting level when initiated from
an interrupt routine. Local memory has a local scope in that it is available only within its
associated program entity, and cannot be accessed by the other program entities. For more
information about Local memory, refer to Local Memory Area: L in this chapter.

Figure 4-3 depicts the flow of a typical scan including the Local memory usage and two interrupt
events, one during the program-execution phase and another during the communications phase
of the scan cycle. Subroutines are called by the next higher level, and are executed when called.
Interrupt routines are not called; they are a result of an occurrence of the associated interrupt
event.
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Processing Any Communications Requests

During the message-processing phase of the scan cycle, the S7-200 processes any messages
that were received from the communications port or intelligent I/O modules.

Executing the CPU Self-test Diagnostics

During this phase of the scan cycle, the S7-200 checks for proper operation of the CPU and for
the status of any expansion modules.

Writing to the Digital Outputs

At the end of every scan cycle, the S7-200 writes the values stored in the process-image output
register to the digital outputs. (Analog outputs are updated immediately, independently from the
scan cycle.)

Accessing the Data of the S7-200

The S7-200 stores information in different memory locations that have unique addresses. You can
explicitly identify the memory address that you want to access. This allows your program to have
direct access to the information. Table 4-1 shows the range of integer values that can be
represented by the different sizes of data.

Table 4-1 Decimal and Hexadecimal Ranges for the Different Sizes of Data

Representation Byte (B) Word (W) Double Word (D)
Unsigned Integer 0to 255 0to 65,535 0 to 4,294,967,295
Oto FF 0 to FFFF 0 to FFFF FFFF
Signed Integer -128to +127 | -32,768 to +32,767 | -2,147,483,648 to +2,147,483,647
80to 7F 8000 to 7FFF 8000 0000 to 7FFF FFFF
Real Not applicable ' Not applicable +1.175495E-38 to +3.402823E+38 (positive)
IEEE 32-bit -1.175495E-38 to -3.402823E+38 (negative)

Floating Point

To access a bit in a memory area, you specify the address, which includes the memory area
identifier, the byte address, and the bit number. Figure 4-4 shows an example of accessing a bit
(which is also called “byte.bit” addressing). In this example, the memory area and byte address
(I'=input, and 3 = byte 3) are followed by a period (*.”) to separate the bit address (bit 4).

I 3 . 4 .

Process-image Input (I) Memory Area

L Bitof byte, or bit number: ge Input () y

bit 4 of 8 (0 to 7) 76 543210
Period separates the Byte 0
byte address from the bit Byte 1
number Byte 2

Byte address: byte 3 (the Byte 3 .

fourth byte) Byte 4
Byte 5

Memory area identifier

Figure 4-4 Byte.Bit Addressing

You can access data in most memory areas (V, I, Q, M, S, L, and SM) as bytes, words, or double
words by using the byte-address format. To access a byte, word, or double word of data in the
memory, you must specify the address in a way similar to specifying the address for a bit. This
includes an area identifier, data size designation, and the starting byte address of the byte, word,
or double-word value, as shown in Figure 4-5.
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Data in other memory areas (such as T, C, HC, and the accumulators) are accessed by using an
address format that includes an area identifier and a device number.

V B 100 V W 100 V D 100
[ Byte address [ Byte address [ Byte address
Access to a byte size Access to a word size Access to a double word size
Area identifier Area identifier Area identifier
MSB LSB

vB100 |7 vB100  °]

MSB = most significant bit
LSB = least significant bit
Most significant byte Least significant byte
MSB LSB
VW100 |15 VB100 87  vBo1 9
Most significant byte Least significant byte
MSB LSB

VD100 |3 vB100 24|28  vB101  6[15 vB102  8[7 vB103 O

Figure 4-5 Comparing Byte, Word, and Double-Word Access to the Same Address

Accessing Data in the Memory Areas

Process-Image Input Register: |

The S7-200 samples the physical input points at the beginning of each scan cycle and writes
these values to the process-image input register. You can access the process-image input register
in bits, bytes, words, or double words:

Bit: I[byte address].[bit address] 10.1
Byte, Word, or Double Word: I[size][starting byte address] 1B4

Process-Image Output Register: Q

At the end of the scan cycle, the S7-200 copies the values stored in the process-image output
register to the physical output points. You can access the process-image output register in bits,
bytes, words, or double words:

Bit: Q[byte address].[bit address] Q1.1
Byte, Word, or Double Word: Ql[size][starting byte address] QB5

Variable Memory Area: V

You can use V memory to store intermediate results of operations being performed by the control
logic in your program. You can also use V memory to store other data pertaining to your process
or task. You can access the V memory area in bits, bytes, words, or double words:

Bit: V[byte address].[bit address] V10.2
Byte, Word, or Double Word: V[size][starting byte address] VW100

Bit Memory Area: M

You can use the bit memory area (M memory) as control relays to store the intermediate status of
an operation or other control information. You can access the bit memory area in bits, bytes,
words, or double words:

Bit: M[byte address].[bit address] M26.7
Byte, Word, or Double Word: M[size][starting byte address] MD20
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Timer Memory Area: T

The S7-200 provides timers that count increments of time in resolutions (time-base increments) of
1 ms, 10 ms, or 100 ms. Two variables are associated with a timer:

1 Current value: this 16-bit signed integer stores the amount of time counted by the timer.

[ Timer bit: this bit is set or cleared as a result of comparing the current and the preset value.
The preset value is entered as part of the timer instruction.

You access both of these variables by using the timer address (T + timer number). Access to
either the timer bit or the current value is dependent on the instruction used: instructions with bit
operands access the timer bit, while instructions with word operands access the current value. As
shown in Figure 4-6, the Normally Open Contact instruction accesses the timer bit, while the Move
Word instruction accesses the current value of the timer.

Format: T[timer number] T24
> ENM\C,)VV- Current Value Timer Bits | |T3|
TO T0 ‘ b
T3—IN  OUT |— Vw200 1 1
T2 T2
" |15 (MsB) T3 0 (LSB) T3

Accesses the current value Accesses the timer bit

Figure 4-6

Accessing the Timer Bit or the Current Value of a Timer

Counter Memory Area: C

The S7-200 provides three types of counters that count each low-to-high transition event on the
counter input(s): one type counts up only, one type counts down only, and one type counts both
up and down. Two variables are associated with a counter:

[ Current value: this 16-bit signed integer stores the accumulated count.

1 Counter bit: this bit is set or cleared as a result of comparing the current and the preset
value. The preset value is entered as part of the counter instruction.

You access both of these variables by using the counter address (C + counter number). Access to
either the counter bit or the current value is dependent on the instruction used: instructions with bit
operands access the counter bit, while instructions with word operands access the current value.
As shown in Figure 4-7, the Normally Open Contact instruction accesses the counter bit, while the
Move Word instruction accesses the current value of the counter.

Format: C[counter number] C24
2.1

E,znov_w Current Value Counter Bits | |C3|
co co ‘ b

c3—{IN OUT [— VW200 c1 c1

| Cc2 Cc2

15 (MSB) C3 0 (LSB) C3

Accesses the current value Accesses the counter bit
Figure 4-7 Accessing the Counter Bit or the Current Value of a Counter
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High-Speed Counters: HC

The high-speed counters count high-speed events independent of the CPU scan. High-speed
counters have a signed, 32-bit integer counting value (or current value). To access the count
value for the high-speed counter, you specify the address of the high-speed counter, using the
memory type (HC) and the counter number (such as HCO). The current value of the high-speed
counter is a read-only value and can be addressed only as a double word (32 bits).

Format: HC[high-speed counter number] HC1

Accumulators: AC

The accumulators are read/write devices that can be used like memory. For example, you can use
accumulators to pass parameters to and from subroutines and to store intermediate values used
in a calculation. The S7-200 provides four 32-bit accumulators (ACO, AC1, AC2, and AC3). You
can access the data in the accumulators as bytes, words, or double words.

The size of the data being accessed is determined by the instruction that is used to access the
accumulator. As shown in Figure 4-8, you use the least significant 8 or 16 bits of the value that is
stored in the accumulator to access the accumulator as bytes or words. To access the
accumulator as a double word, you use all 32 bits.

For information about how to use the accumulators within interrupt subroutines, refer to the
Interrupt Instructions in Chapter 6.

Format: AC[accumulator number] ACO

Network 1
MO0 MoV B AC2 (accessed as a byte) msB LsB

— p——fn Eeno— | ! g

ACZ24IN OUTFwE200

Metwork 2
AC1 (accessed as aword)  msB LSB
KA1 DEC_W 15 8 7 o
_| | BN ENO >| | | Most significant Least significant
actdn outhwwion Byte 1 Byte 0
Network 3 AC3 (accessed as a double word)
MSB LSB
MO.2 IN_DW 31 24 23 16 15 8 7 0
_| | BN ENO >| | Most significant | Least significant
acadn outhvooso Byte 3 Byte 2 Byte 1 Byte O

Figure 4-8 Accessing the Accumulators
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Special Memory: SM

The SM bits provide a means for communicating information between the CPU and your program.
You can use these bits to select and control some of the special functions of the S7-200 CPU,
such as: a bit that turns on for the first scan cycle, a bit that toggles at a fixed rate, or a bit that
shows the status of math or operational instructions. (For more information about the SM bits, see
Appendix D.) You can access the SM bits as bits, bytes, words, or double words:

Bit: SM[byte address].[bit address] SMO0.1
Byte, Word, or Double Word: SM[size][starting byte address] SMB86

Local Memory Area: L

The S7-200 provides 64 bytes of local memory of which 60 can be used as scratchpad memory or
for passing formal parameters to subroutines.

Tip
If you are programming in either LAD or FBD, STEP 7-Micro/WIN reserves the last four bytes of
local memory for its own use.

Local memory is similar to V memory with one major exception. V memory has a global scope
while L memory has a local scope. The term global scope means that the same memory location
can be accessed from any program entity (main program, subroutines, or interrupt routines). The
term local scope means that the memory allocation is associated with a particular program entity.
The S7-200 allocates 64 bytes of L memory for the main program, 64 bytes for each subroutine
nesting level, and 64 bytes for interrupt routines.

The allocation of L memory for the main program cannot be accessed from subroutines or from
interrupt routines. A subroutine cannot access the L memory allocation of the main program, an
interrupt routine, or another subroutine. Likewise, an interrupt routine cannot access the L memory
allocation of the main program or of a subroutine.

The allocation of L memory is made by the S7-200 on an as-needed basis. This means that while
the main portion of the program is being executed, the L memory allocations for subroutines and
interrupt routines do not exist. At the time that an interrupt occurs or a subroutine is called, local
memory is allocated as required. The new allocation of L memory might reuse the same L
memory locations of a different subroutine or interrupt routine.

The L memory is not initialized by the S7-200 at the time of allocation and might contain any
value. When you pass formal parameters in a subroutine call, the values of the parameters being
passed are placed by the S7-200 in the appropriate L memory locations of the called subroutine. L
memory locations, which do not receive a value as a result of the formal parameter passing step,
will not be initialized and might contain any value at the time of allocation.

Bit: L[byte address].[bit address] LO.0
Byte, Word, or Double Word: L[size] [starting byte address] LB33

Analog Inputs: Al

The S7-200 converts an analog value (such as temperature or voltage) into a word-length (16-bit)
digital value. You access these values by the area identifier (Al), size of the data (W), and the
starting byte address. Since analog inputs are words and always start on even-number bytes
(such as 0, 2, or 4), you access them with even-number byte addresses (such as AIWO0, AIW2, or
AIW4). Analog input values are read-only values.

Format: AlW(starting byte address] Alw4
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Analog Outputs: AQ

The S7-200 converts a word-length (16-bit) digital value into a current or voltage, proportional to
the digital value (such as for a current or voltage). You write these values by the area identifier
(AQ), size of the data (W), and the starting byte address. Since analog outputs are words and
always start on even-number bytes (such as 0, 2, or 4), you write them with even-number byte
addresses (such as AQWO0, AQW2, or AQW4). Analog output values are write-only values.

Format: AQW(starting byte address] AQWA4

Sequence Control Relay (SCR) Memory Area: S

SCRs or S bits are used to organize machine operations or steps into equivalent program
segments. SCRs allow logical segmentation of the control program. You can access the S bits as
bits, bytes, words, or double words.

Bit: S[byte address].[bit address] S3.1
Byte, Word, or Double Word: S[size][starting byte address] SB4

Format for Real Numbers

Real (or floating-point) numbers are represented as 32-bit, single-precision numbers, whose
format is described in the ANSV/IEEE 754-1985 standard. See Figure 4-9. Real numbers are
accessed in double-word lengths.

For the S7-200, floating point numbers are MSB LSB
accurate up to 6 decimal places. Therefore, 81 30 23 22 _ 0
you can specify a maximum of 6 decimal | S | Exponent Mantissa

places when entering a floating-point Sign

constant. Figure 4-9  Format of a Real Number
Accuracy when Calculating Real Numbers

Calculations that involve a long series of values including very large and very small numbers can
produce inaccurate results. This can occur if the numbers differ by 10 to the power of x,
where x > 6.

For example: 100 000 000 + 1 =100 000 000

Format for Strings

A string is a sequence of characters, with each character being stored as a byte. The first byte of
the string defines the length of the string, which is the number of characters. Figure 4-10 shows
the format for a string. A string can have a length of 0 to 254 characters, plus the length byte, so
the maximum length for a string is 255 bytes. A string constant is limited to 126 bytes.

| Length | Character 1 | Character 2 | Character 3 | Character 4 | . | Character 254

Byte O Byte 1 Byte 2 Byte 3 Byte 4 Byte 254

Figure 4-10  Format for Strings
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Specifying a Constant Value for S7-200 Instructions

You can use a constant value in many of the S7-200 instructions. Constants can be bytes, words,
or double words. The S7-200 stores all constants as binary numbers, which can then be
represented in decimal, hexadecimal, ASCII, or real number (floating point) formats. See

Table 4-2.

Table 4-2 Representation of Constant Values

Representation Format Sample

Decimal [decimal value] 20047

Hexadecimal 16#[hexadecimal value] 16#4E4F

Binary 2#[binary number] 2#1010_0101_1010_0101

ASCII 'TASCII text]’ "ABCD’

Real ANSI/IEEE 754-1985 +1.175495E-38 (positive) -1.175495E-38 (negative)
String “[stringtext]” “ABCDE”"

Tip

@ The S7-200 CPU does not support “data typing” or data checking (such as specifying that the
constant is stored as an integer, a signed integer, or a double integer). For example, an Add
instruction can use the value in VW100 as a signed integer value, while an Exclusive Or
instruction can use the same value in VW100 as an unsigned binary value.

Addressing the Local and Expansion I/O

The local I/O provided by the CPU provides a fixed set of /O addresses. You can add I/O points to
the S7-200 CPU by connecting expansion /O modules to the right side of the CPU, forming an 1/0O
chain. The addresses of the points of the module are determined by the type of I/O and the
position of the module in the chain, with respect to the preceding input or output module of the
same type. For example, an output module does not affect the addresses of the points on an input
module, and vice versa. Likewise, analog modules do not affect the addressing of digital modules,
and vice versa.

Tip

@ Process-image register space for digital I/O is always reserved in increments of eight bits (one
byte). If a module does not provide a physical point for each bit of each reserved byte, these
unused bits cannot be assigned to subsequent modules in the I/O chain. For input modules, the
unused bits are set to zero with each input update cycle.

Analog I/O points are always allocated in increments of two points. If a module does not provide
physical I/O for each of these points, these I/O points are lost and are not available for
assignment to subsequent modules in the 1/O chain.
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Figure 4-11 provides an example of the /O numbering for a particular hardware configuration. The
gaps in the addressing (shown as gray italic text) cannot be used by your program.

4 Analog In 4 Analog In
CPU 224XP ‘ 41In/4 Out ‘ 81In 1 Analog Out 1 Analog Out
10.0 Q0.0 Module 0 Module 1 Module 2 Module 3 Module 4
10.1 Q0.1 120 Q20 13.0 AlW4 AQW4 Q3.0 AIW12  AQWS
10.2 Q0.2 21 Q21 13.1 AIW6 AQW6 Q3.1 AW14  AQWIO0
10.3 Q0.3 22 Q2.2 13.2 AlWS Q3.2 AIW16
10.4 Q0.4 123 Q23 13.3 AIW10 Q3.3 AIW18
10.5 Q0.5 24 Q24 13.4 Q3.4
10.6 Q0.6 125 Q25 13.5 Q35
10.7 Q0.7 26 Q26 13.6 Q3.6
1.0 QL0 27 Q27 13.7 Q3.7
1.1 QL1
1.2 QL2 Expansion 1/O
1.3 Q1.3
114 QL4
L5 QL5
1.6 QL6
1.7 QL7
AIWO AQWO
AlW2 AQW2
Local I/O

Figure 4-11  Sample I/O Addresses for Local and Expansion I/O (CPU 224XP)
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Using Pointers for Indirect Addressing of the S7-200 Memory Areas

Indirect addressing uses a pointer to access the data in memory. Pointers are double word
memory locations that contain the address of another memory location. You can only use

V memory locations, L memory locations, or accumulator registers (AC1, AC2, AC3) as pointers.
To create a pointer, you must use the Move Double Word instruction to move the address of the
indirectly addressed memory location to the pointer location. Pointers can also be passed to a
subroutine as a parameter.

The S7-200 allows pointers to access the following memory areas: I, Q, V, M, S, Al, AQ, SM,
T (current value only), and C (current value only). You cannot use indirect addressing to access
an individual bit or to access HC or L memory areas.

To indirectly access the data in a memory address, you create a pointer to that location by
entering an ampersand (&) and the memory location to be addressed. The input operand of the
instruction must be preceded with an ampersand (&) to signify that the address of a memory
location, instead of its contents, is to be moved into the location identified in the output operand of
the instruction (the pointer).

Entering an asterisk (*) in front of an operand for an instruction specifies that the operand is a
pointer. As shown in Figure 4-12, entering *AC1 specifies that AC1 is a pointer to the word-length
value being referenced by the Move Word (MOVW) instruction. In this example, the values stored
in both VB200 and VB201 are moved to accumulator ACO.

AC1
V199 | address of VW200 | <—— MOVD &VW200, AC1

V200 12 1 Creates the pointer by moving the address of VB200
V201 34 (address of the initial byte for VW200) to AC1.

V202 56 ACO

vaos | 78 | | 1234 |<— movw *AC1, ACO

Moves the word value pointed to by AC1 to ACO.

Figure 4-12  Creating and Using a Pointer
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As shown in Figure 4-13, you can change the value of a pointer. Since pointers are 32-bit values,
use double-word instructions to modify pointer values. Simple mathematical operations, such as
adding or incrementing, can be used to modify pointer values.

V199 ACL
| address of VW200 |<— MOVD &VW200, AC1
V200 12 N Creates the pointer by moving the address of
V201 34 S| ACO l VB200 (address of VW200's initial byte) to AC1.
V202 56 | | 1234 | MOVW *AC1, ACO
V203 78 Moves the word value pointed to by
AC1 (VW200) to ACO.
ACL
V199
| address of VW202 |<— +D  +2, AC1
V200 12 ACO Adds 2 to the accumulator to point to the
V201 34 next word location.
V02 | 56 | | 5675 | MOVW *AC1, ACO
] T Moves the word value pointed to by
V203 78 AC1 (VW202) to ACO.
Figure 4-13  Modifying a Pointer
Tip

¥

Remember to adjust for the size of the data that you are accessing: to access a byte, increment

the pointer value by 1; to access a word or a current value for a timer or counter, add or
increment the pointer value by 2; and to access a double word, add or increment the pointer

value by 4.

Sample Program for Using an Offset to Access Data in V Memory

This example uses LD10 as a pointer to the address VBO. You then increment the pointer by an offset stored in VD1004.
LD10 then points to another address in V memory (VBO + offset). The value stored in the V memory address pointed to
by LD10 is then copied to VB1900. By changing the value in VD1004, you can access any V memory location.

Network 1 //How to use an offset to read the value

%l

FLD10

LD

FLD10 +D

HNetwork 1

SMO.0 WOV_O
— | EN ENO
gvBodin_ ouT

A0D_DI
EN  ENO
vD1004diM1  ouT

LD104im2

MO _B
EM  ENO
=o104M__ out

%l

F/E1900

/lof any VB location:

1

/[1. Load the starting address of the
/IV memory to a pointer.

/[2. Add the offset value to the pointer.
/3. Copy the value from the V memory
/Nlocation (offset) to VB1900.

1

SMO0.0

MOVD &VBO, LD10
VD1004, LD10
MOVB *LD10, VB1900
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Sample Program for Using a Pointer to Access Data in a Table

This example uses LD14 as a pointer to a recipe stored in a table of recipes that begins at VB100. In this example,
VW1008 stores the index to a specific recipe in the table. If each recipe in the table is 50 bytes long, you multiply the
index by 50 to obtain the offset for the starting address of a specific recipe. By adding the offset to the pointer, you can
access the individual recipe from the table. In this example, the recipe is copied to the 50 bytes that start at VB1500.

Network 1
SMD.D WOW_DW
[
— | EN  ENO—)
avB1oodN__ oUTkLD14
(5]
EN ENOH
wwioosdin___ ouThLD18
WUL_DI
EN  ENO—)
w501 outhLD1s
LD18 Iz
ADD_D
EN  ENO—)
Loisdmt  ouThLD14
LD1 44z
BLKMOY_B
EN  ENO—)
1D14dIN ouThvBTS00
s04n

Network 1 //How to transfer a recipe from a table of recipes:

LD
MOVD
ITD

*D

+D
BMB

I -
Il -
1
1
/1.
1
112.
1
113.
1
114,
115.
1

SMO0.0

Each recipe is 50 bytes long.
The index parameter (VW1008) identifies
the recipe to be loaded.

Create a pointer to the starting address
of the recipe table.

Convert the index of the recipe to a
double-word value.

Multiply the offset to accommodate

the size of each recipe.

Add the adjusted offset to the pointer.
Transfer the selected recipe to
VB1500 through VB1549.

&VB100, LD14
VW1008, LD18
+50, LD18

LD18, LD14
*LD14, VB1500, 50

Understanding How the S7-200 Saves and Restores Data

The S7-200 provides a variety of features to ensure that your user program and data are properly

retained in the S7-200.

1 Retentive Data Memory - Areas of data memory the user selects to remain unchanged
over a power cycle, as long as the super capacitor and the optional battery cartridge have
not been discharged. V, M, Timer Currents, and Counter Currents are the only data memory
areas that are configurable to be retentive.

Permanent Memory - Non-volatile memory used to store the program block, data block,

system block, forced values, M memory configured to be saved on loss of power, and
selected values written under user program control

a

Memory Cartridge - Removable non-volatile memory used to store the program block, data

block, system block, recipes, data logs, and forced values

You can use the S7-200 Explorer to store documentation files (doc, text, pdf, etc.) into the
cartridge. You can also use the S7-200 Explorer to perform general file maintenance on the
memory cartridge (copy, delete, directory and launch).

To install a memory cartridge, remove the plastic slot cover from the S7-200 CPU and insert the
memory cartridge in the slot. The memory cartridge is keyed for proper installation.

Caution

Electrostatic discharge can damage the memory cartridge or the receptacle on the S7-200 CPU.

Make contact with a grounded conductive pad and/or wear a grounded wrist strap when you
handle the cartridge. Store the cartridge in a conductive container.
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Downloading and Uploading the Elements of Your Project
Your project consists of different elements:

1 Program block

1 Data block (optional)

1 System block (optional)

1 Recipes (optional)

1 Data log configurations (optional)
When you download a project, the program block, data block and system block are stored in
permanent memory for safekeeping. Recipes and data log configurations are stored in the
memory cartridge, and replace any existing recipes and data logs. Any program elements not

included in the download operation are left unchanged in permanent memory and the memory
cartridge.

If a project download includes recipes or
data log configurations, the memory
cartridge must remain installed for proper
program operation.

To download your project to an S7-200
CPU:

1. Selectthe File > Download menu
command.

2. Click each project element you
wish to download.

3. Click the Download Button.

Figure 4-14 Download a Project to S7-200 CPU

When you upload a project to your computer using STEP 7-Micro/WIN, the S7-200 uploads the
program block, data block and system block from permanent memory. The recipes and data log
configurations are uploaded from the memory cartridge. The data from the data logs is not
uploaded to your computer using STEP7-Micro/WIN. The S7-200 Explorer is used to upload the
data from the data logs (see Chapter 14).

To upload your project from an S7-200
CPU:

1. Selectthe File > Upload menu
command.

2. Click each project element that you
wish to upload.

3. Click the Upload Button.

Figure 4-15 Upload a Project to the S7-200
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Storing your Program on a Memory Cartridge

The S7-200 allows you to copy your user program from one CPU to another using a memory
cartridge. You can also distribute updates for any of the following blocks in your S7-200: the
program block, system block or data block.

Before copying any program elements to the memory cartridge, STEP 7-Micro/WIN deletes all
program elements (including recipes and data logs) except for user files on the memory cartridge.
If your program will not fit because of the size of your files, you can do one of two things to create
enough storage space for your program. You can either erase the memory cartridge using the
PLC > Erase Memory Cartridge menu command. Or, you can open the S7-200 Explorer and
remove user files that are no longer needed.

The PLC must be in STOP mode to program the memory cartridge.

To store your program in the memory
cartridge:

1. Selectthe PLC > Program
Memory Cartridge menu
command.

2. Click each project element you
wish to copy to the memory
cartridge (all program elements
that exist in your project are
selected by default). If the system
block is selected the force values
will be copied as well.

3. Click the Program Button
Figure 4-16 Store a Program on a Memory Cartridge

The program block, system block, data block, and any forced values are copied from permanent
memory in the S7-200 to the memory cartridge. The recipes and data log configurations are
copied from STEP 7-Micro/WIN to the memory cartridge.

Restoring a Program from a Memory Cartridge

To transfer the program from a memory cartridge to the S7-200, you must apply power to the
S7-200 with the memory cartridge installed. If any of the blocks or force values present in the
memory cartridge are different from the blocks or force values in the S7-200, then all blocks
present in the memory cartridge are copied to the S7-200.

1 Ifa program block was transferred from the memory cartridge, the program block in
permanent memory is replaced.

1 If adata block was transferred from the memory cartridge, the data block in permanent
memory is replaced, all of V memory is cleared, and V memory is initialized with the
contents of the data block.

1 If a system block was transferred from the memory cartridge, the system block and force
values in the permanent memory are replaced and all retentive memory is cleared.

Once the transferred program has been stored to permanent memory you can remove the
memory cartridge. However, if recipes or data logs are present in the cartridge, you must leave
the memory cartridge installed. Leaving the memory cartridge installed will delay entry to RUN
mode on subsequent power cycles.

Notice

Powering on an S7-200 CPU with an installed memory cartridge that was programmed by a
different model of S7-200 CPU can cause an error. Memory cartridges that are programmed by
a lower model number CPU can be read by a higher model number CPU. However, the
opposite is not true. For example, memory cartridges that are programmed by a CPU 221 or
CPU 222 can be read by a CPU 224, but memory cartridges that are programmed by a

CPU 224 are rejected by a CPU 221 or CPU 222.

For a complete list of memory cartridge usage restrictions, see Optional Cartridges (Memory
Cartridge) in Appendix A.
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Saving the Retentive M Memory Area on Power Loss

If you configured any of the first 14 bytes of bit memory (MBO to MB13) to be retentive, these
bytes are saved to permanent memory when the S7-200 loses power. By default, the first 14
bytes of M memory are selected to be non-retentive.

Restoring Data after Power On

When power is applied, the S7-200 restores the program block and the system block from
permanent memory. The S7-200 then verifies that the super capacitor and optional battery
cartridge, if installed, has successfully maintained the data stored in RAM memory. If the data was
successfully maintained, the retentive areas of user data memory are left unchanged. The
non-retentive portions of V. memory are restored from the contents of the data block in permanent
memory. The non-retentive portions of other memory areas are cleared.

If the contents of RAM were not maintained (such as after an extended power failure), the S7-200
clears all user data areas, sets the Retentive Data Lost memory bit (SMO0.2), restores V memory
from the contents of the data block in permanent memory, and restores the first 14 bytes of

M memory from permanent memory if these bytes were previously configured as retentive.

Using Your Program to Save V Memory to Permanent Memory

You can save a value (byte, word, or double word) stored in any location of the V memory area to
permanent memory. A save to permanent memory operation typically increases the scan time by
10 to 15 ms. The value written by the Save operation overwrites any previous value stored in the
V memory area of permanent memory.

The save to permanent memory operation does not update the data in the memory cartridge.

Tip

Since the number of save operations to the permanent memory (EEPROM) is limited (100,000
minimum, and 1,000,000 typical), you should ensure that only necessary values are saved.
Otherwise, the EEPROM can wear out and the CPU can fail. Typically, you should perform save
operations at the occurrence of specific events that occur rather infrequently.

For example, if the scan time of the S7-200 is 50 ms and a value was saved once per scan, the
EEPROM would last a minimum of 5,000 seconds, which is less than an hour and a half. On the
other hand, if a value were saved once an hour, the EEPROM would last a minimum of 11
years.

Copying V Memory to Permanent Memory

Special Memory Byte 31 (SMB31) commands the S7-200 to copy a value in V memory to the
V memory area of permanent memory. Special Memory Word 32 (SMW32) stores the address
location of the value that is to be copied. Figure 4-17 shows the format of SMB31 and SMW32.

Use the following steps to program the S7-200 to SMB31
7

o Size of value to be

save or write a specific value in V. memory: saved:
|sv | o|o| o| o| 0 |sl| so| 00 - byte
01 - byte
1. Loadthe V memory address of the value to | 10 - word
be saved in SMW32. Save to permanent memory: 11 - double word
. . 0=No
2. Load the size of the data in SM31.0 and 1=Yes \ The CPU resets
SM31.1, as shown in Figure 4-17. SM3L7 after each

save operation.

3. SetSM31.7 to 1.
SMW32
At the end of every scan cycle, the S7-200 checks 15 V memory address o|
SM31.7; if SM31.7 equals 1, the specified value is
saved to permanent memory. The operation is
complete when the S7-200 resets SM31.7 to O.

Specify the V memory address as an offset from VO.

Do not change the value in V memory until the Figure 4-17 SMB31 and SMW32
save operation is complete.
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Copying V Memory to permanent memory can be used to save values that are created from an
HMI and stored from the program to the internal EEPROM.

To include the values saved to the internal EEPROM in your STEP 7-Micro/WIN project, you
must upload the DB. However, this upload is only possible if the DB (which included a variable
that was at an equal or higher address than the V Memory address saved in SMW32) was
previously downloaded from STEP 7-Micro/WIN.

Sample Program: Copying V Memory to the Permanent Memory

This example transfers VB100 to permanent memory. On a rising edge of 10.0, if another transfer is not in progress, it
loads the address of the V memory location to be transferred to SMW32. It selects the amount of V memory to transfer
(1=Byte; 2=Word; 3=Double Word or Real). It then sets SM31.7 to have the S7-200 transfer the data at the end of the

scan.

The S7-200 automatically resets SM31.7 when the transfer is complete.

Hetwork 1
0.0

Network 1 /[Transfer a V memory
. Lo fr-Sll? MOV_w¢ /llocation (VB100) to
I 1P 11 EN eno—) /I[permanent memory
+1004IM ouTh Mz LD 10.0
EU
AN SM31.7
Mov_B MOVW  +100, SMW32
@ o MovB 1, SMB3L
14n ouT| 5MB31 S SM31.7,1
SMaT

—( )

Selecting the Operating Mode for the S7-200 CPU

40

The S7-200 has two modes of operation: STOP mode and RUN mode. The status LEDs on the
front of the CPU indicates the current mode of operation. In STOP mode, the S7-200 is not
executing the program, and you can download a program or the CPU configuration. In RUN
mode, the S7-200 is running the program.

1 The S7-200 provides a mode switch for changing the mode of operation. You can use the

mode switch (located under the front access door of the S7-200) to manually select the
operating mode: setting the mode switch to STOP mode stops the execution of the
program; setting the mode switch to RUN mode starts the execution of the program; and
setting the mode switch to TERM (terminal) mode does not change the operating mode.

If a power cycle occurs when the mode switch is set to either STOP or TERM, the S7-200
goes automatically to STOP mode when power is restored. If a power cycle occurs when
the mode switch is set to RUN, the S7-200 goes to RUN mode when power is restored.

STEP 7-Micro/WIN allows you to change the operating mode of the online S7-200. To
enable the software to change the operating mode, you must manually set the mode switch
on the S7-200 to either TERM or RUN. You can use the PLC > STOP or PLC > RUN menu
commands or the associated buttons on the toolbar to change the operating mode.

You can insert the STOP instruction in your program to change the S7-200 to STOP mode.
This allows you to halt the execution of your program based on the program logic. For more
information about the STOP instruction, see Chapter 6.
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Using the S7-200 Explorer

The S7-200 Explorer is an extension to
the Windows Explorer application that
provides access to S7-200 PLCs and
allows the contents of each connected
PLC to be explored. The different blocks
that may reside in either the PLC or the
memory cartridge can be determined.
Properties are available for each block.

Since the S7-200 Explorer is an

extension to the Windows Explorer

application, standard Windows Figure 4-18 S7-200 Explorer
navigation and behaviors are supported.

The S7-200 Explorer is the mechanism used to read data log data stored within the memory
cartridge. Refer to Chapter 14 for more information about data logs.

The S7-200 Explorer can also be used to read or write user files to the memory cartridge. These
can be any type of files, Word documents, bitmap files, jpeg files, or STEP 7-Micro/WIN projects.

Features of the S7-200

The S7-200 provides several special features that allow you to customize how the S7-200
functions to better fit your application.

The S7-200 Allows Your Program to Immediately Read or Write the 1/O

The S7-200 instruction set provides instructions that immediately read from or write to the physical
1/0. These immediate 1/O instructions allow direct access to the actual input or output point, even
though the image registers are normally used as either the source or the destination for /O
accesses.

The corresponding process-image input register location is not modified when you use an
immediate instruction to access an input point. The corresponding process-image output register
location is updated simultaneously when you use an immediate instruction to access an output
point.

Tip
@ The S7-200 handles reads of analog inputs as immediate data, unless you enable analog input
filtering. When you write a value to an analog output, the output is updated immediately.

It is usually advantageous to use the process-image register rather than to directly access inputs
or outputs during the execution of your program. There are three reasons for using the image
registers:

1 The sampling of all inputs at the start of the scan synchronizes and freezes the values of
the inputs for the program execution phase of the scan cycle. The outputs are updated from
the image register after the execution of the program is complete. This provides a stabilizing
effect on the system.

1 Your program can access the image register much more quickly than it can access /0
points, allowing faster execution of the program.

1 /O points are bit entities and must be accessed as bits or bytes, but you can access the
image register as bits, bytes, words, or double words. Thus, the image registers provide
additional flexibility.
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The S7-200 Allows Your Program to Interrupt the Scan Cycle

If you use interrupts, the routines associated with each interrupt event are stored as part of the
program. The interrupt routines are not executed as part of the normal scan cycle, but are
executed when the interrupt event occurs (which could be at any point in the scan cycle).

Interrupts are serviced by the S7-200 on a first-come-first-served basis within their respective
priority assignments. See the Interrupt instructions in Chapter 6 for more information.

The S7-200 Allows You to Allocate Processing Time for Run Mode Edit
and Execution Status

You can configure a percentage of the scan cycle to be dedicated for processing a run mode edit
compilation or execution status. (Run mode edit and execution status are options provided by
STEP 7-Micro/WIN to make debugging your program easier.) As you increase the percentage of
time that is dedicated to these two tasks, you increase the scan time, which makes your control
process run more slowly.

The default percentage of the scan dedicated to processing run mode edits and execution status
is set to 10%. This setting was chosen to provide a reasonable compromise for processing the
compilation and status operations while minimizing the impact to your control process. You can
adjust this value by 5% increments up to a maximum of 50%. To set the scan cycle time-slice for
background communications:

1. Selectthe View > Component >
System Block menu command
and select Background Time.

2. Inthe Background tab, use the
drop down box to select the
communications background time.

3. Click OK to save your selection.

4. Download the modified system
block to the S7-200.

Figure 4-19 Communications Background Time
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The S7-200 Allows You to Set the States of Digital Outputs for Stop
Mode

The output table of the S7-200 allows you to determine whether to set the state of the digital
output points to known values upon a transition to the STOP mode, or to leave the outputs in the
state they were in before the transition to the STOP mode. The output table is part of the system
block that is downloaded and stored in the S7-200.

1. Selectthe View > Component >
System Block menu command
and select Output Table. Click on
the Digital tab.

2. To freeze the outputs in their last
state, select the Freeze Outputs
checkbox.

3. To copy the table values to the
outputs, enter the output table
values by clicking the checkbox for
each output bit you want to set to
On (1) after a run-to-stop transition.
The default values of the table are
all zeroes.

4. Click OK to save your selections.

5. Download the modified system Figure 4-20 Digital Output Table
block to the S7-200.

The S7-200 Allows You to Configure the Value of Analog Outputs

The Analog Output Table allows you to set analog output points to known values after a
RUN-to-STOP transition, or to preserve the output values that existed before the transition to
STOP mode. The Analog Output table is part of the system block that is downloaded and stored in
the S7-200 CPU.

1. Select the View > Component >
System Block menu command
and select Output Table. Click on
the Analog tab.

2. To freeze the outputs in their last
state, select the Freeze Outputs
check box.

3. The Freeze Values table allows
you to set the analog outputs to a
known value (-32768 to 37262),
on a RUN-to-STOP transition.

4. Click OK to save your selections.

5. Download the modified system
block to the S7-200.

Figure 4-21 Analog Output Table

The S7-200 Allows You to Define Memory to Be Retained on Loss of
Power
You can define up to six retentive ranges to select the areas of memory you want to retain through
power cycles. You can define ranges of addresses in the following memory areas to be retentive:

V, M, C, and T. For timers, only the retentive timers (TONR) can be retained. The default setting for
the first 14 bytes of M Memory is to be non-retentive.

Only the current values for timers and counters can be retained: the timer and counter bits are not
retentive.
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Tip
@ Changing the range MBO to MB13 to be retentive enables a special feature that automatically
saves these locations to the permanent memory on power down.

To define the retentive memory:

1. Selectthe View > Component >
System Block menu command
and select Retentive Ranges.

2. Select the ranges of memory to be
retained following loss of power
and click OK.

3. Download the modified system
block to the S7-200.

Figure 4-22 Retentive Memory

The S7-200 Allows You to Filter the Digital Inputs

The S7-200 allows you to select an input filter that defines a delay time (selectable from 0.2 ms to
12.8 ms) for some or all of the local digital input points. This delay helps to filter noise on the input
wiring that could cause inadvertent changes to the states of the inputs.

The input filter is part of the system block
that is downloaded and stored in the
S7-200. The default filter time is 6.4 ms.
As shown in Figure 4-23, each delay
specification applies to groups of input
points.

To configure the delay times for the input
filter:

1. Selectthe View > Component >
System Block menu command
and select Input Filters. Click on
the Digital tab.

2. Enter the amount of delay for each
group of inputs and click OK.

3. Download the modified system

Figure 4-23 Digital Input Filter
block to the S7-200.

Tip

@ The digital input filter affects the input value as seen by instruction reads, input interrupts, and
pulse catches. Depending on your filter selection, your program could miss an interrupt event or
pulse catch. The high speed counters count the events on the unfiltered inputs.
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The S7-200 Allows You to Filter the Analog Inputs

¥

The S7-200 allows you to select software filtering on individual analog inputs. The filtered value is
the average value of a preselected number of samples of the analog input. The filter specification
(number of samples and deadband) is the same for all analog inputs for which filtering is enabled.

The filter has a fast response feature to allow large changes to be quickly reflected in the filter
value. The filter makes a step function change to the latest analog input value when the input
exceeds a specified change from the current value. This change, called the deadband, is
specified in counts of the digital value of the analog input.

The default configuration is to enable
filtering for all analog inputs except AIWO
and AIW2 on CPU 224XP.

1. Selectthe View > Component >
System Block menu command
and select Input Filters. Click on
the Analog tab.

2. Select the analog inputs that you
want to filter, the number of
samples, and the deadband.

3. Click OK.

4. Download the modified system
block to the S7-200.

Figure 4-24 Analog Input Filter
Tip
Do not use the analog filter with modules that pass digital information or alarm indications in the

analog words. Always disable analog filtering for RTD, Thermocouple, and AS-Interface Master
modules.

Tip
AIWO0 and AIW2 on the CPU 224XP are filtered by the analog to digital converter, and usually
will not need the additional software filter.

The S7-200 Allows You to Catch Pulses of Short Duration

The S7-200 provides a pulse catch feature which can be used for some or all of the local digital
input points. The pulse catch feature allows you to capture high-going pulses or low-going pulses
that are of such a short duration that they would not always be seen when the S7-200 reads the
digital inputs at the beginning of the scan cycle. When pulse catch is enabled for an input, a
change in state of the input is latched and held until the next input cycle update. This ensures that
a pulse which lasts for a short period of time is caught and held until the S7-200 reads the inputs.

You can individually enable the pulse
catch operation for each of the local
digital inputs.

To access the pulse catch configuration
screen:

1. Selectthe View > Component >
System Block menu command
and select Pulse Catch Bits.

2. Click the corresponding check box
and click OK.

3. Download the modified system
block to the S7-200.

Figure 4-25 Pulse Catch

45



S7-200 Programmable Controller System Manual

Figure 4-26 shows the basic operation of the S7-200 with and without pulse catch enabled.

Scan cycle ‘ Next scan cycle

[

Physical Input

The S7-200 misses this pulse because the input
turned on and off before the S7-200 updated the
process-image input register

Output from
pulse catch ‘

Disabled |

\

\
Enabled

T Input update T Input update
\ \
| \
\ \
\
\
\

The S7-200 catches the pulse on the physical input

Figure 4-26  Operation of the S7-200 with the Pulse Catch Feature Enabled and Disabled

Because the pulse catch function operates on the input after it passes through the input filter, you
must adjust the input filter time so that the pulse is not removed by the filter. Figure 4-27 shows a
block diagram of the digital input circuit.

- - r—— B
Optical Digital Input Pulse
® Isolation Filter Catch Llnput to S7_200J|
External f
Digital Input Pulse Catch Enable

Figure 4-27  Digital Input Circuit

Figure 4-28 shows the response of an enabled pulse catch function to various input conditions. If
you have more than one pulse in a given scan, only the first pulse is read. If you have multiple
pulses in a given scan, you should use the rising/falling edge interrupt events. (For a listing of
interrupt events, see Table 6-46.)

Scan cycle Next scan cycle
Input update Input update
Input to pulse catch L
\
Output from pulse catch
|
Input to pulse catch LT ‘

|

1

\ \

Output from pulse catch T o
|

Input to pulse catch ‘ I_;_l
i

Output from pulse catch

Figure 4-28  Responses of the Pulse Catch Function to Various Input Conditions
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The S7-200 Provides a User-Controlled LED

The S7-200 provides an LED (SF/DIAG) that can indicate red (system fault LED) or yellow
(diagnostic LED). The diagnostic LED can be illuminated under user program control, or can
automatically illuminate under certain conditions: when an 1/O point or data value is forced, or
when a module has an I/O error.

To configure the automatic selections for
the diagnostic LED:

1. Selectthe View > Component >
System Block menu command
and select Configure LED.

2. Click each item to either enable or
disable turning on the LED when
an I/O point or data value is forced,
or when a module has an I/O error.

3. Download the modified system
block to the S7-200.

To control the state of the diagnostic LED
with your user program, use the
Diagnostic LED instruction in Chapter 6.  Figure 4-29 Diagnostic LED

The S7-200 Maintains a History Log of Major CPU Events

The S7-200 maintains a log that contains
a time-stamped history of major CPL_J — s T T I
events, such as when power is applied, 04/05/04 022643 Trarstionto RON

04405404 02:26:43 Paower up
When the CPU enters RUN que’ and 04/05/04 02:26:25 Transition to BUMN
when fatal errors occur. Your time-of-day 04/05/04 022624 Powerwp

clock must be configured in order to get
valid time and date stamps on the log
entries.

To view the Event History log, select the

PLC > Information menu command and
select Event History. Figure 4-30 Viewing the Event History Log

The S7-200 Allows You to Increase Your Available User Program
Memory

The S7-200 allows you to disable the run
mode edit feature in the CPU 224,

CPU 224XP, and CPU 226 in order to
increase the amount of program memory
available for your use. Refer to Table 1-1
to see the amount of program memory
for each CPU model.

To disable the run mode edit feature,
follow these steps

1. Selectthe View > System Block
menu command and select
Increase Program Memory.

2. Click the Increase Memory item to
disable the run mode edit feature.

3. Download the modified system

Figure 4-31 Disable Run Mode Edit
block to the S7-200.
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The S7-200 Provides Password Protection

¥

All models of the S7-200 provide password protection for restricting access to specific functions.

A password authorizes access to the functions and memory: without a password, the S7-200
provides unrestricted access. When it is password protected, the S7-200 limits all restricted
operations according to the configuration provided when the password was installed

The password is not case-sensitive.

As shown in Table 4-3, the S7-200 provides four levels of access restriction. Each level allows
certain functions to be accessible without a password. For the four levels of access, entering the
correct password provides access to the functions as noted below. The default condition for the
S7-200 is level 1 (no restriction).

Entering the password over a network does not compromise the password protection for the
S7-200.

You can in effect, disable the password by changing the password level 4, 3, or 2 to Level 1, since
Level 1 allows all unrestricted CPU access.

Table 4-3 Restricting Access to the S7-200
CPU Function Level 1 Level 2 Level 3 Level 4

Read and write user data

Start, Stop, and Power-Up Reset

of the CPU Access allowed | Access allowed
Read and write the time-of-day Access allowed
Clock
Upload the user program, data, Never allowed
and the CPU configuration
Download of Program Block, Data Password
Block or System Block required (Never
allowed for
System Block)
Runtime Edits Never allowed
Delete of Program Block, Data Password
Block, or System Data Block Access allowed required (Never
allowed for
System Block
Password y )
Copy of Program Block, Data Password required
Block, or Sys_tem Data Block to the required
memory cartridge
Force data in status chart
Password
Execute the single or multiple scan required

Writing of output in STOP mode

Reset of scan rates in PLC
information

Execution status

- Never allowed
Project compare

Having one user authorized to access restricted functions Reset of Scan Rates in PLC information
does not authorize other users to access those functions. Only one user is allowed unrestricted
access to the S7-200 at a time.

Tip

After you enter the password, the authorization level for that password remains effective for up
to one minute after the programming device has been disconnected from the S7-200. Always
exit STEP 7-Micro/WIN before disconnecting the cable to prevent another user from accessing
the privileges of the programming device.
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Configuring a Password for the S7-200

The System Block dialog box (Figure 4-32) allows you to configure a password for the S7-200.
The default condition for the S7-200 is set at Full (Level 1), no restriction.

1. Selectthe View > Component >
System Block menu command to
display the System Block dialog
box and select Password.

2. Select the appropriate level of
access for the S7-200.

3. Enter and verify the password for
Partial (Level 2) or Minimum
(Level 3).

4. Click OK.

5. Download the modified system
block to the S7-200.

Figure 4-32 Creating a Password

Recovering from a Lost Password

If you forget the password, you must clear the memory of the S7-200 and reload your program.
Clearing the memory puts the S7-200 in STOP mode and resets the S7-200 to the factory-set
defaults, except for the network address, baud rate, and the time-of-day clock. To clear your
program in the S7-200:

1. Selectthe PLC > Clear menu command to display the Clear dialog box.
2. Select all three blocks and confirm your action by clicking OK.

3. If a password had been configured, STEP 7-Micro/WIN displays a password-authorization
dialog box. To clear the password, enter CLEARPLC in the password-authorization dialog
box to continue the Clear All operation. (The CLEARPLC password is not case sensitive.)

The Clear All operation does not remove the program from a memory cartridge. Since the memory
cartridge stores the password along with the program, you must also reprogram the memory
cartridge to remove the lost password.

Warning

Clearing the S7-200 memory causes the outputs to turn off (or in the case of an analog output,
to be frozen at a specific value).

If the S7-200 is connected to equipment when you clear the memory, changes in the state of the
outputs can be transmitted to the equipment. If you had configured the “safe state” for the
outputs to be different from the factory settings, changes in the outputs could cause
unpredictable operation of your equipment, which in turn could cause death or serious injury to
personnel, and/or damage to equipment.

Always follow appropriate safety precautions and ensure that your process is in a safe state
before clearing the S7-200 memory.
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The S7-200 Provides Analog Adjustment Potentiometers

The analog adjustment potentiometers are located under the front access cover of the module.
You can adjust these potentiometers to increase or decrease values that are stored in bytes of
Special Memory (SMB). These read-only values can be used by the program for a variety of
functions, such as updating the current value for a timer or a counter, entering or changing the
preset values, or setting limits. Use a small screwdriver to make the adjustments: turn the
potentiometer clockwise (to the right) to increase the value, and counterclockwise (to the left) to
decrease the value.

SMB28 holds the digital value that represents the position of analog adjustment 0. SMB29 holds
the digital value that represents the position of analog adjustment 1. The analog adjustment has a
nominal range of 0 to 255 and a repeatability of +2 counts.

Sample Program for Referencing the Value Entered with the Analog Adjustment Potentiometers

Network 1 Network 1 //Read analog adjustment 0 (SMB28).
] Bl //Save the value as an integer in VW100.

—en  Eenol—3y LD 10.0

BTI SMB28, VW100

SMB284IM QUT w100

Network 2 //Use the integer value (VW100) as
/la preset for a timer.

LDN Q0.0

Network 2 TON  T33, VW100
Q0.0 733 ’
— + |—~ 7w
Network 3 /[Turn on Q0.0 when T33 reaches
W 004PT__ 10ms /lthe preset value.
LD T33
= Q0.0
Metwork 3
733 0o

The S7-200 Provides High-speed 1/0

High-Speed Counters

The S7-200 provides integrated high-speed counter functions that count high speed external
events without degrading the performance of the S7-200. See Appendix A for the rates supported
by your CPU model. Each counter has dedicated inputs for clocks, direction control, reset, and
start, where these functions are supported. You can select different quadrature modes for varying
the counting rate. For more information on high-speed counters, see Chapter 6.

High-Speed Pulse Output

The S7-200 supports high-speed pulse outputs, with outputs Q0.0 and Q0.1 generating either a
high-speed pulse train output (PTO) or pulse width modulation (PWM).

The PTO function provides a square wave (50% duty cycle) output for a specified number of
pulses (from 1 to 4,294,967,295 pulses) and a specified cycle time (in either microsecond or
millisecond increments. You can program the PTO function to produce either one train of pulses or
a pulse profile consisting of multiple trains of pulses. For example, you can use a pulse profile to
control a stepper motor through a simple ramp up, run, and ramp down sequence or more
complicated sequences.

The PWM function provides a fixed cycle time with a variable duty cycle output, with the cycle time
and the pulse width specified in either microsecond or millisecond increments. When the pulse
width is equal to the cycle time, the duty cycle is 100 percent and the output is turned on
continuously. When the pulse width is zero, the duty cycle is 0 percent and the output is turned off.

For more information on the high-speed pulse output instruction, see Chapter 6. For more
information about using PTO in open loop motion control, see Chapter 9.
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Programming Concepts, Conventions,

and Features

The S7-200 continuously executes your program to control a task or process. You use

STEP 7-Micro/WIN to create this program and download it to the S7-200. STEP 7-Micro/WIN

provides a variety of tools and features for designing, implementing, and debugging your program.

In This Chapter

Guidelines for Designing a Micro PLC System . ... . it

Basic Elements of a Program ........

Using STEP 7-Micro/WIN to Create Your Programs . ............couuiiniiinannaenaen..
Choosing Between the SIMATIC and IEC 1131-3 Instruction Sets ......................
Understanding the Conventions Used by the Program Editors . .........................
Using Wizards To Help You Create Your Control Program .. ............ ... ...

Handling Errors in the S7-200 .......

Assigning Addresses and Initial Values in the Data Block Editor ........................
Using the Symbol Table for Symbolic Addressing of Variables . .........................

Using Local Variables ..............

Using the Status Chart to Monitor Your Program ... ... ... i

Creating an Instruction Library .......

Features for Debugging Your Program
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Guidelines for Designing a Micro PLC System

There are many methods for designing a Micro PLC system. The following general guidelines can
apply to many design projects. Of course, you must follow the directives of your own company’s
procedures and the accepted practices of your own training and location.

Partition Your Process or Machine

Divide your process or machine into sections that have a level of independence from each other.
These partitions determine the boundaries between controllers and influence the functional
description specifications and the assignment of resources.

Create the Functional Specifications

Write the descriptions of operation for each section of the process or machine. Include the
following topics: 1/O points, functional description of the operation, states that must be achieved
before allowing action for each actuator (such as solenoids, motors, and drives), description of the
operator interface, and any interfaces with other sections of the process or machine.

Design the Safety Circuits

Identify equipment requiring hard-wired logic for safety. Control devices can fail in an unsafe
manner, producing unexpected startup or change in the operation of machinery. Where
unexpected or incorrect operation of the machinery could result in physical injury to people or
significant property damage, consideration should be given to the use of electro-mechanical
overrides which operate independently of the S7-200 to prevent unsafe operations. The following
tasks should be included in the design of safety circuits:

1 Identify improper or unexpected operation of actuators that cou